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FactoryTalk Design Workbench Getting Results Guide

Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this
equipment before you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation
and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried
out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or
application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements
associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the
examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in
this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may lead to personal
injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or economic loss.
Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

> >

IMPORTANT: |dentifies information that is critical for successful application and understanding of the product.

These labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach dangerous temperatures.

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc Flash. Arc Flash
will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements for safe work practices and for
Personal Protective Equipment (PPE).

B> > >

The following icon may appear in the text of this document.

Q |dentifies information that is useful and can help to make a process easier to do or easier to understand.

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication are not in alignment
with the movement toward inclusive language in technology. We are proactively collaborating with industry peers to find alternatives to
such terms and making changes to our products and content. Please excuse the use of such terms in our content while we implement
these changes.
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Preface

The document set includes:

FactoryTalk Design Workbench Getting Results Guide (publication FTDW-GRO01). Use this manual to get started with the FactoryTalk®
Design Workbench™ development environment. The manual is available in _Rockwell Automation® Literature Library.

Help: Use this comprehensive Help for assistance when using FactoryTalk Design Workbench.

Micro800 Programmable Controllers General Instructions (publication 2080-RM003): Use this manual for reference information about
the instruction set available for developing programs for use in Micro800™ control systems. The manual is available in Rockwell
Automation Literature Library.

Summary of Changes

This manual has new and updated information. Use these reference tables to locate new or changed information. Grammatical and editorial
style changes are not included in this summary.

Global changes

None for this release.

New or enhanced features

This table has a list of topics changed in this version, the reason for the change, and a link to the topic that has the changed information.

The identified changes will fall into one of these categories:

New feature
Enhanced feature
Functional change
Anomaly fix

Usability improvement

Clarification

Table 1. Summary of changes

Category Topic name Reason
New feature User interface on page 14 Updated the user interface (Ul) screenshot and Ul
item description to reflect the run mode change (RMC)
function.
New feature »  Controller run mode change on page 65 Added topics to document the RMC function.
*  Run mode change actions on page 65
*  Run mode change toolbar on page 67
»  Make run mode changes on page 67
Clarification Throughout the book Replaced abbreviated controller names with their full

Micro800 equivalents to improve consistency.

Rockwell Automation, Inc. FTDW-GROOTB-EN-P - April 2026 7
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Table 1. Summary of changes (continued)

Category Topic name Reason

Clarification Connect to a Micro800 controller on page 46 Enhanced the topic by adding guidance on
discovering controllers and refining step 1for better
understanding.

Clarification Discover and add a controller connected to a Enhanced the topic by refining steps from 1through 5
computer on page 36 for better understanding.
About this book

This manual provides information on how to get started using the FactoryTalk Design Workbench software. It is not intended to be a
comprehensive user guide. For complete information on all features, tasks, and components, refer to Help.

Legal Notices

Rockwell Automation publishes legal notices, such as privacy policies, license agreements, trademark disclosures, and other terms and
conditions on the Legal Notices page of the Rockwell Automation website.

Software and Cloud Services Agreement

View and sign the Rockwell Automation Software and Cloud Services Agreement here.

Third-Party Software Licenses
View a full list of all third-party software used in this product here, including:

» Open-source software
» Commercial software
*  Other third-party free software

You may obtain Corresponding Source code for open-source packages included in this product from their respective project websites.
Alternatively, you may obtain the complete Corresponding Source code by contacting Rockwell Automation via the Contact form at the
bottom of the Rockwell Automation website: http://www.rockwellautomation.com/global/about-us/contact/contact.page. Please include
"Open Source” as part of the comments for your General Inquiry request.
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Chapter 1

FactoryTalk Design Workbench overview

FactoryTalk Design Workbench is an on-premises development environment that provides
web-based access for configuring devices and programming Micro800 controllers. FactoryTalk
Design Workbench version 1.00.00 supports Micro800 controllers, allowing one controller in each
project. Later versions will support more devices.

This section describes:

+  System requirements
» How to install the FactoryTalk Design Workbenchsoftware

FactoryTalk Design Workbench works within the system requirements of all Rockwell
Automation® software products. For the latest compatibility information, refer to the Product
Compatibility and Download Center.

Hardware requirements

 Processor: Intel® Core™ ib Standard Power processor (i5-3xxxx) or equivalent
recommended. At least 2 processors should be assigned when running FactoryTalk
Design Workbench on a virtual machine.

*  RAM: 8 GB minimum
 Hard disk space: 20 GB free

Software requirements

The following operating systems are supported and recommended*:
«  Windows Server® 2025 Standard (Recommended 0S)**
«  Windows Server 2022 Standard (Recommended 0S)**
»  Windows Server 2019
+  Windows® 11 Enterprise 64-bit (Recommended 0S)
«  Windows 11 Professional 64-bit (Recommended 0S)
«  Windows 11 Enterprise 2024 LTSC 64-bit (v24H2)
Windows 11 10T Enterprise 2024 LTSC 64-bit (v24H2)***
Windows 10 Enterprise 2019 LTSC 64-bit (v1809)
Windows 10 Enterprise 2021 LTSC 64-bit (v21H2)
Windows 10 loT Enterprise 2021 LTSC 64-bit (v21H2)**

*The recommended operating systems have priority for Microsoft Patch Qualifications with
Rockwell Automation software.

FTDW-GROOTB-EN-P - April 2026 9
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**Windows Server Datacenter editions are supported. The key difference between Windows
Server Standard and Datacenter edition is how Microsoft licenses the operating system.
Windows Server Standard includes licensing for up to two virtual machines per core license,
making it suitable for lightly virtualized environments. Datacenter edition allows unlimited
virtual machines per core license, offering better value for highly virtualized or cloud-scale
deployments.

***Windows 11 loT Enterprise LTSC and Windows 11 Enterprise LTSC are binary equivalents but
are licensed differently. Windows 10 loT Enterprise LTSC and Windows 10 Enterprise LTSC are
binary equivalents but are licensed differently.

Rockwell Automation's software installation policy is based on the lifecycle information of
Microsoft operating systems. If an operating system's lifecycle state is approaching its end, you
may encounter a warning message when trying to install Rockwell Automation software on it.

’ ) .| Rockwell Automation installation Rockwell Automation installation
Microsoft lifecycle policy . | . .
warning policy prevention policy
Fixed Present a warning message during Prevent installation on Microsoft
installation on Microsoft operating operating systems that are six months
systems that are 18 months before past Microsoft's extended end date.

Microsoft's extended end date.

Modern Present a warning message during Prevent installation on Microsoft
installation on Microsoft operating operating systems that are six months
systems that are 18 months before past Microsoft's retirement date.

Microsoft's retirement date.

The following table illustrates how the installation policy is applied using the current operating
systems. For the latest compatibility information, refer to the Microsoft Lifecycle Policy and
Product Compatibility and Download Center.

Operating Microsoft Extended end . Installation Installation
| | Retirement date )

system lifecycle policy | date warning prevented

Windows 11 Modern None None None None

Enterprise and
Professional
editions

Windows 10 Modern None October 14,2025 | April 14, 2024 April 14, 2026
Enterprise and
Professional
editions

Windows Server | Fixed October 10, 2034 | None April 10, 2033 April 10, 2035
2025 Standard
and Datacenter
editions

Windows Server | Fixed October 14,2031 | None April 14,2030 April 14,2032
2022 Standard

FTDW-GROOTB-EN-P - April 2026 Rockwell Automation, Inc.
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Operating Microsoft Extended end . Installation Installation
| | Retirement date )
system lifecycle policy | date warning prevented

and Datacenter
editions

Supported browsers
* Google® Chrome™ browser
* Microsoft Edge™

* Mozilla® Firefox®

High Resolution Display Support

Windows 10 version 1803 or later is the recommended operating system when using this
software with a 2K or 4K high-resolution display. For optimal user experiences, ensure that the
Windows recommended scaling rate is applied, especially for 4K displays. Using other scaling
rate might cause scrollbar functionality issues.

Rockwell Automation Test Environment

Rockwell Automation tests software products under a standard configuration of operating
systems and antivirus software. For additional information, see the Knowledgebase Document
ID: PN24 - Rockwell Software Products and Antivirus Software.

Security requirements
To learn about designing a secure networking environment, review this publication:

«  Configuring Firewalls for FactoryTalk Services Platform (publication FTSP-RM001) shows
the ports, services, and firewall rules necessary for FactoryTalk® Services Platform
components to function properly.

«  Converged Plantwide Ethernet (CPwE) Design and Implementation Guide (publication
ENET-TDOOT) is built on, and adds to, design guidelines from the Cisco Ethernet-to-the-
Factory (EttF) solution and the Rockwell Automation Integrated Architecture™.

To learn about implementing application-level security using FactoryTalk Security, review this
publication:

« FactoryTalk Security Application Technigue (publication SECURE-AT002) explains how to
use FactoryTalk Security to implement authentication and authorization in your industrial
automation system and how to enforce product-specific security for applications like
Studio 5000 Logix Designer, FactoryTalk View, and FactoryTalk AssetCentre.
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To learn about designing and implementing an architecture with device-level security using CIP
Security, review these publications:

«  System Security Design Guidelines Reference Manual (publication SECURE-RMO01)
provides guidelines for how to use Rockwell Automation products to improve the security
of your industrial automation system.

«  Configure System Security Features User Manual (publication SECURE-UMOOT1) describes
the system-level configuration requirements to use a controller that has achieved IEC
62443-4-2:2019 certification.

«  CIP Security with Rockwell Automation Products Application Technique (publication
SECURE-ATOQT) explains how to implement the Common Industrial Protocol (CIP) Security
standard in your industrial automation control system (IACS).

Install FactoryTalk Design Workbench

Follow the steps to install FactoryTalk Design Workbench. Ensure that you have administrative
rights in Windows.

O To use Software Center Configuration Manager (SCCM), install it with a user account or manually install
Visual Studio shell 2013 before installing FactoryTalk Design Workbench.

To install FactoryTalk Design Workbench

1. From Product Compatibility and Downloads Center, download the current version of

FactoryTalk Design Workbench.

2. Inthe installation package, double-click Setup.exe.

3. Onthe welcome page, select a language to be shown during the installation process. By
default, your system language is selected.

4. Toinstall all components available using the recommended settings, select Install now,

and then skip to step 9.

5. To select which component to install, select Customize.
6.  On the Customize page, select the components. There might be three options shown:

- Mandatory (grayed-out and selected checkbox) indicates software that will be
automatically installed as part of the selected application.

- Recommended (selected checkbox) indicates software that Rockwell Automation
recommends for the application. You might decide to clear the checkbox so the
software does not install.

- Optional (clear checkbox) indicates software that you might wish to include
depending on your system. Select the box to include the software during installation.

1. Select the location for the Rockwell Automation software, and then select Install. The

default locationis C: \ .

8. InThat'sit!, select Close to exit the installation, or:

- Select Installation Summary to see the installation details.

- Select Register for updates to learn how to receive email updates about product
patches.

- Select Download it free to install Adobe Acrobat Reader.

Unattended or silent install

Use command-line parameters to perform an unattended or silent installation of the software.

12 FTDW-GROOTB-EN-P - April 2026 Rockwell Automation, Inc.
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Installation Command-line parameters

Use command Setup.exe /? to display the usage options for installation parameters. Command-
line parameters are case-insensitive. If a specified value includes a space, be sure to enclose
the value in quotation marks (for example, "value with spaces").

Examples
The following examples show how to use the installation commands.

» Toinstall the software with no user interface using the default settings during the
installation process. (Silent install)

Setup. exe /Q /1 Accept Al |l Li censeTer ns

+ Toinstall the Chinese language version of the software on the D: drive and display the
progress, error, or complete messages during installation and restart the computer if
necessary. (Unattended install)

Set up. exe / QS /1 Accept Al | Li censeTerns / Aut oRestart /
Set upLanguage=CHS /I nstal | Dri ve=D:

Error codes

The following table identifies the error codes that can be returned by an installation.

Error Code Value Description

ERROR_SUCCESS 0 The installation completed successfully.
ERROR_INVALID_PARAMETER 87 One of the parameters was invalid.
ERROR_INSTALL_USEREXIT 1602 The installation was canceled by the user.
ERROR_INSTALL_FAILURE 1603 Afatal error occurred during installation.
ERROR_BAD_CONFIGURATION 1610 The configuration data for this product is corrupt.

Contact your support personnel.

ERROR_SUCCESS_REBOOT_INITIATED | 1641 The installer has initiated a restart. After restart, the
installation will continue.

ERROR_SUCCESS_REBOOT_REQUIRED | 3010 Arestart is required to complete the installation. After
restart, the product is successfully installed.

ERROR_REBOOT_PENDING 3012 Restart pending. Restart the computer for the
installation to continue.

ERROR_SUCCESS_NOT_APPLICABLE | 3013 The installation cannot proceed because the products
are already installed.

ERROR_SUCCESS_WARNING_REBOOT | 3014 The installation succeeded with warnings. Check
the installation log file for details. To complete the
installation, restart the computer.
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User interface

Use the FactoryTalk Design Workbench user interface (Ul) to create projects, specify which
panes to view, and reset to the default layout if necessary.

Figure 1. FactoryTalk Design Workbench user interface
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Table 2. Items on the Ul
Item Name Description
1 Menu bar on page Contains the menu items for FactoryTalk Design Workbench and the
19 active window.
2 Toolbar Contains:
+ The Save and Online center buttons.
= The run mode change (RMC) toolbar with buttons to start online
editing, test, accept, and finalize changes during RMC.
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Table 2. Items on the Ul (continued)

Item Name Description

If RMC changes are ongaing, not tested, or not accepted in a

Program Organization Unit (POU), the following icons appear

beside that POU in Project Organizer to indicate the changes:

- f indicates that there are ongoing or unsaved RMC
changes. Before recannecting to the controller, you can
choose to resume editing.

- N indicates that testing is in progress on a POU. Before
reconnecting to the controller, you can choose to continue
testing the POU.

3 Project Organizer on | Displays the devices, I/0 configurations, and program elements of
page 17 the project in an organized tree view.
4 Pane bar on page Contains the button toggles you use to show or hide specific panes.

23

Output pane on page
%

Contains:
» AConsole page that displays the added devices, their
connection status, and log entries.

« AnError list page that displays the descriptions, locations, and
time stamps of errors, warnings, and messages.

» AlLog page that displays the log descriptions and time stamps.

Workspace

Contains the options to configure devices and build programs. The
content varies with the page you open.

)

Connection pane

For each added device, the Connection pane contains:

» The device name and catalog number.

+ The connection path to connect to the device if any.

+ The toggle to connect to or disconnect from the device.

»  The Controller mode list to view and change the controller
connection mode.

The Fault button to open the Micro800 controller's fault
diagnostics on page 51 page.

 The Diagnose button to open the controller and communication
diagnostics pages on page 50.

» The Secure button to open the pages to set, clear, or change
the controller password.

©

Toolbox on page
100

Contains the logic elements and instructions that can be added to
the opened language editor.

>~

Properties pane on
page 27

Displays the properties of a selected item.

You can edit the properties in the Properties pane.
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Table 2. Items on the Ul (continued)

Item

Description

Error indicator

Displays the total number of errors in the current project, counting
only errors from POUs that are built and verified.

Warning indicator

Displays the total number of warnings in the current project,
counting only errors from POUs that are built and verified.

Welcome page

When you open FactoryTalk Design Workbench, the Weleome page opens by default.

Use Welcome to:

Create a project.
Open a project.
Import a project.

View the most recently opened projects. The information of up to 25 projects is

displayed.

Select X to close Welcome. To reopen it, from the File menu, select Welcome.

Figure 2. Welcome page

@ Design Workbenc!

[3 New project
[ Open project
[& Import project

Help

X
Recent Projects

Project name Last opened
Temperature_Moenitoring_Project_3_1 an hour ago
Sorting_System_Control 3 days ago
My_Micro810_Project a month ago
Micro820_Startup_Project_1 amonth ago
Energy_Management_Controller a month ago
Drill_Press_Centreller a month ago
Micro810_Testing_Project a month ago
Flow_Manitoring_Project a month ago
Micro820_Startup_Project a month ago
Filling_Machine_Automaticn a month age
Plant1_Automation a month ago
Conveyor_Microg850_Project a month ago
Lighting_Control_Solution a month ago
Moter_Centrol_System a month ago
Pump_station_Configuration a month ago

About dialog

Use the About dialog to view the following information:

 The product name and version.

» The name and version of the added devices.

FTDW-GROOTB-EN-P - April 2026
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Project manager

Project Organizer

Rockwell Automation, Inc.

 The copyright information.
« Thelink to the release notes.

To open About, from the Help menu, select About.

Project manager lists all FactoryTalk Design Workbench projects on your computer, with the
project names and the time stamps of their last editing.

Use Project manager to:

 Batch-export projects to your computer.

 Batch-delete projects from your computer.

* Rename projects.
When a project is opened in FactoryTalk Design Workbench, you cannot perform any of the
actions.

To open Project manager, from the File menu, select Project manager.

Figure 3. Project manager

Project manager 8
Q) Search
] Project name Last opened
[[]  Temperature_Monitoring_.. an hour ago
[ | sorting_System_Control 3 days ago
[ My_Microg10_Project a month ago
[]  Microg820_startup_Project... a month ago
|:| Energy_Management_Con... a month ago
[ Drill_Press_Controller a month ago
|:| Micro810_Testing_Project a month ago
[ Flow_Monitoring_Project a month ago
[]  MicroB20_startup_Project a month ago
Help -W‘

Project Organizer displays the devices and program elements of the project in an organized
tree view. Use Project Organizer to open additional device configuration workspaces and
manage program elements. If no device is added, use the New device on page 35 or Discover
Device on page 36 button to add one. Elements displayed in Project Organizer vary with the
added device.
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For projects that contain a Micro800 controller, Project Organizer displays the following items
that are associated with the controller:

» (lobal variables
» Logic programs on page 80

» Assets, including user-defined functions, user-defined function blocks, and user-defined
data types

* 1/0 configurations

Figure 4. Project Organizer
Project Organizer =

LB
Q, Search

+ [ MyProject [2080-L20E-20AWE]*
& Global Varniables
% Programs
» % Assels
%t User-Defined Function Blocks
% User-Defined Functlons
- B Data Types
2 Amays
2 Structures
2 Defined Words
«» % 170 Configurations
B Embedded
B Plug-in [0/2]
B Ethernet [0/4]

Table 3. Icons in Project Organizer

Item Description

E+ Opens Add device to add devices to the project.
o

) Deletes the selected device from the project.
&

Opens Select Device to view a list of devices that are connected to the
computer.

Commands in Project Organizer

Use Project Organizer to open and edit additional device configuration options. Micro800
controllers and drives are available in Project Organizer.

Commands available for Micro800 controllers

Table 4. Commands available by right-clicking the Micro800 controller in Project Organizer

Right-click and select To

Build Build the current project on page 43.
Connect Connect to a Micro800 controller on page 46.
18 FTDW-GROOTB-EN-P - April 2026 Rockwell Automation, Inc.
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Menu bar

Rockwell Automation, Inc.

Table 4. Commands available by right-clicking the Micro800 controller in Project Organizer

(continued)

Right-click and select

To

Disconnect Disconnect from a Micro800 controller on page 51.

Download Download a controller configuration to a Micro800 controller on page 47.
Upload Upload a controller configuration from a Micro800controller on page 47.
Clean Clean controller faults on page 51.

Fault Open <controller-name>:Fault to view and clear controller faults.
Diagnose Monitor and diagnose a Micro800 controller on page 50.

Secure Set, change, or clear a controller password on page 37.

Change Controller

Replace the Micro800 controller in the project with a different Micro800 model on page
42,

Import > Global variables

Open Import global variables to import variables from a CSV or XLSX file on page 75.

Import > Data types

Open Import Data types to import data types from an M8A file on page 77.

Export > Global variables

Open Export global variables to export global variables to a CSV or XLSX file on page
72.

Export > Data types

Open Export data types to export data types to an M8A file on page 73.

Delete

Remove the Micro800 controller from Project Organizer. You can also use the Delete
key.

Data protection

Open Data protection on page 39 to add or remove variables from a list of the
protected variables.

Memory module backup
and restore

Open Memory module backup and restore to configure the relevant settings and
start the backup or restore process.

Commands available for Class 1devices, plug-in modules, and expansion

modules

Table 5. Commands available by right-clicking a Class 1device, plug-in module, or expansion
module in Project Organizer

Right-click and
select

To

Delete Remove a drive, plug-in module, or expansion module from Project Organizer. You can also use

the Delete key to remove the device.

The menu bar contains the menu items for the active window.
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Table 6. Items on the men

u bar

Use this menu

To

File

Create, open, or close a project.
Save a project to your local drive.
Duplicate a project to the same location using a different name.

Import or export projects on page 68.

Open Welcome on page 16.
Open Project manager on page 17.

Open Settings on page 126 to configure global options.
Close FactoryTalk Design Workbench.

Edit

Modify content in the active window.

Device

Perform the actions that are available by right-clicking the Micro800 controller in
Project Organizer.

View

Select which panes to display on page 20.

Reset the layout on page 21.

Window

Select which page to open in the workspace on page 20.

Help

Open About on page 16.

View tabs

In FactoryTalk Design Workbench, pages open for different functions. Use the Window menu to
select which page to view or close.

To view tabs

1.
2.

From the menu

View panes

bar, select Window.

From the Window menu:

Select Next tab to view the next opened page.

Select Previous tab to view the previously opened page.

Select Close tab to close the current page.

Select Close all tabs to close all opened pages.

Select All tabs to view a list of opened pages and select which page to view.

Use the View menu to display or hide specific panes. The location, pinned status, and visibility
of panes are reserved after closing and reopening FactoryTalk Design Workbench.

Table 7. View menu items

Select

To

Pane > Pin

Pin the selected pane to the current location.

20
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Reset the layout

Keyboard shortcuts

Rockwell Automation, Inc.

Table 7. View menu items (continued)

Select To

Pane > Unpin Unpin the selected pane.

Pane > Collapse Hide the content of the selected pane.

Pane > Expand Display the content of the selected pane.

Pane > Close Close the selected pane.

Left panes Display or hide the panes that are last pinned to the left side of the user interface (Ul).
Right panes Display or hide the panes that are last pinned to the right side of the UL.

Bottom panes

Display or hide the panes that are last pinned at the bottom of the Ul.

Reset layout Restore panes to their default locations, pinned status, and visibility.

Project organizer Display or hide Project Organizer. Project Organizer is pinned to the left side of the
Ul by default.

Properties Display or hide Properties. The pane is pinned to the lower right of the Ul by default.

Toolbox Display or hide Toolbox. The pane is pinned to the upper right of the Ul by default.

Connection Display or hide Connection. The pane is hidden by default.

Output > Console Display Output with the Console page opened.

Output > Error list Display Output with the Error list page opened.

Output > Log Display Output with the Log page opened.

Reset the layout to restore the panes to their default locations, pinned status, and visibility.
Layout changes are reserved after closing and reopening FactoryTalk Design Workbench.

To reset the layout

+ From the View menu, select Reset layout.

The following table introduces the keyboard shortcuts that apply universally.

Table 8. Keyboard shortcuts

Keyboard .
Name Description
Shortcut
Select all Ctrl+A Selects all elements on the current page.
Show/hide bottom | Ctrl+Shift+B | Displays or hides the panes that are last pinned at the bottom of the user
panes interface (Ul).
Copy Ctrl+C Copies the selected element to the clipboard.
Show/hide pane Ctrl+Shift+C | Displays or hides the selected pane.

FTDW-GROOTB-EN-P - April 2026
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Table 8. Keyboard shortcuts (continued)

Keyboard
Name Description
Shortcut P

Find references Ctrl+E Finds all references to the selected variable.

Select variable Ctrl+L Opens Select variable from the ladder diagram (LD), function block diagram
(FBD), or structured text (ST) editor to select a variable for the selected
operand.

Show/hide left Ctrl+Shift+L | Displays or hides the panes that are last pinned to the left side of the Ul.

panes

Toggle inline value | Ctrl+M Displays or hides the values of the variables.

display

New project Ctri+N Opens New project to create a project when no project is opened.

Open project Ctrl+0 Opens Open project to select and open a recently opened project when no
project is opened.

Pin/unpin panes Ctrl+Shift+P | Pins or unpins the selected pane.

Add rung Ctrl+R Adds a rung below the selected rung in the LD editor.

Show/hide right Ctrl+Shift+R | Displays or hides the panes that are last pinned to the right of the Ul.

panes

Save Ctrl+S Saves the controller project.

Save as Ctrl+Shift+S | Saves a copy of the controller project.

Toggle bit Ctrl+T Switches a Boolean variable between on and off states.

Paste Ctri+V Pastes the selected element to the selected position.

New variable Ctrl+W Opens New variable to create a variable at the current location in the LD,
FBD, or ST editor.

Cut Ctri+X Cuts the selected element to the clipboard.

Close pane Ctri+Shift+X | Closes the selected pane.

Redo Ctri+Y Redoes the previous command.

Undo Ctrl+Z Undoes the previous command.

Show Connection | Ctrl+Alt+C « Displays the Connection pane if it is hidden.

+ Highlights the Connection if it is already opened.

Show Error list Ctrl+Alt+E Displays the Error list page when the Output pane is selected.

Show Log Ctrl+Alt+L Displays the Log page when the Output pane is selected.

Show/hide Project | Ctrl+Alt+P Displays or hides Project Organizer.

Organizer

Show Console Ctrl+Alt+S Displays the Console page when the Output pane is selected.

Zoomin Ctrl++ Zooms in the language editor.

Zoom out Ctrl+- Zooms out the language editor.

Previous tab Ctrl+ Goes to the previous tab.

FTDW-GROOTB-EN-P - April 2026
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Pane bar
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Table 8. Keyboard shortcuts (continued)

Name :::::;I;d Description

Next tab Ctrl+] Goes to the next tab.

Close and exit Ctrl+F4 Closes the controller project and FactoryTalk Design Workbench.
Close current tab Ctrl+Shift+F4 | Closes the current tab.

Show tab list Ctrl+F10 Shows a list of opened tabs to view or close.

Close project Alt+F4 Closes the current project and returns to the welcome page.

View properties Alt+Enter Shows the properties of the selected element in the Properties pane.
Highlight Toolbox | Alt+Insert Opens and highlights Toolbox. Alt+Insert has the same effect as Insert.
Show/hide FBD grid | Shift+* Displays or hides the grids in the FBD editor.

Open Device menu | Alt+D Opens the Device menu from the menu bar.

Open Edit menu Alt+E Opens the Edit menu from the menu bar.

Open File menu Alt+F Opens the File menu from the menu bar.

Go to rung Alt+6 Opens Go to Rung to enter a rung number to go to.

Open Help menu Alt+H Opens the Help menu from the menu bar.

Open View menu Alt+V Opens the View menu from the menu bar.

Open Window menu | Alt+W Opens the Window menu from the menu bar.

Open Help F1 Opens the context-sensitive Help of FactoryTalk Design Workbench.
Edit F2 Edit the content at the current location.

Delete Delete + Deletes the selected element in the LD or FBD editor.

+ Deletes the selected content or the content to the right of the cursor in
the ST editor.

Use the pane bar to display or hide panes quickly. The following table introduces the button
toggles on the pane bar.

Table 9. Items on the pane bar

Item Name Description Keyboard Shortcut
N | Left panes Displays or hides the panes that are last Ctrl+Shift+L
pinned to the left side of the user interface
(un.
Project Displays or hides Project Organizer. Ctrl+Shift+P
Organizer
[ Right panes Displays or hides the panes that are last Ctrl+Shift+R
pinned to the right side of the Ul.
Toolbox Displays or hides Toolbox. Insert or Alt+Insert
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Table 9. ltems on the pane bar (continued)

Item Name Description Keyboard Shortcut
HI Properties Displays or hides Properties. Alt+Enter
O’h Connection Displays or hides Connection. Ctrl+Alt+C
Bottom panes Displays or hides the panes that are last Ctrl+Shift+B
pinned at the bottom of the Ul.
Output Displays or hides Output. o Ctrl+Alt+S
Displays the Console page
»  Ctrl+Alt+E
Displays the Error list page
o Ctri+Alt+L
Displays the Log page

Output pane
The Output contains the following pages that provide information about the project or the
currently opened page in the workspace:
* Log
+ Error list
» Console
When opening the Output pane, the Log page displays by default unless an error occurs, in
which case the Error list page is shown.
Use the View menu or the pane bar on page 23 to open Output.
Console page
Figure 5. Console page
Output R =
Console Error list Log

@ MyController [2080-L...

o

Q, Search

—©O

Device Description Time

& | MyController [2080-L70E... Disconnect success. 07/30/2025, 01:03:09 PM

(<]

MyController [2080-L70E...
@ MyController [2080-L70E...

Connect success. 07/30/2025, 10:40:23 AM

Download success. 07/30/2025, 10:40:22 AM

Table 10. Items on the Console page

Item Name

Description

Status overview pane Lists the added devices.
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Table 10. Items on the Console page (continued)

Item Name

Description

Select a device from the list to filter the log entries by
device.

When a device is selected, Y displays in the Device

column, indicating that the column is filtered.

e Device Lists the devices that are associated with the generated
information.
e Description Displays the logs about the added devices
o Time Displays the time stamps of the logs.
o Search box Enters the device name and log description to find and
filter the logs.
Error list page
Figure 6. Error list page
3 4 5
Output i =
Console Error list Lpg
o_BUild = ® 1Errors & 0 Warnings @ 0 Messages Q, Search
Description Location Device

& | Expecting a BOOL variable or a BOOL constant

Table T1. Items on the Error list page

HSC_progran_Ru.. = MyController

(7] 8/

Item Name

Description

o Scope list

Selects a scope to filter error messages by specific
context or category.

The scope is General by default.

Search box

Enters the corresponding description, location, or device
to find error messages that match.

Displays or hides the errors.

Warnings button

o Errors button

Displays or hides the warnings.

Rockwell Automation, Inc. FTDW-GROOTB-EN-P - April 2026
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Table T1. Items on the Error list page (continued)

Item Name Description

e Messages button Displays or hides the information messages.

By default, errors, warnings, and messages are displayed
on the Error list page. When there are errors, only errors
are displayed.

6 Description Displays the message content.
o Location Displays the location of errors and their links.
e Device Displays the device name in which the error occurred.

You can select = in the column header to search or

filter errors by device.

Log page

Figure 7. Log page

Console Error list Log

Build =

0 error(s), 0 warnings

——- Build End —

Table 12. Items on the Log page

Item Name Description
o Scope list Selects a scope to filter log messages by specific
context or category.

The scope is General by default.

e Clear log button Clears the log entries about the selected scope.

e Log entries Displays the log entries in this controller project.
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Properties pane

Use the Properties pane to view and edit the properties of items in Project Organizer or
language editors. Properties that appear dimmed are read-only.

The content that displays in the Properties pane varies with the item that you selected.

Table 13. Items in the Properties pane

Selected Item

Content displayed in Properties

Controller

Controller name

Controller catalog number

Program Organization Unit | «  POU name
(PoU) «  POU description
Instruction * Instruction name

Instruction description
EN/ENO

Input Number of the input operands for the selected instructions, such as the
ADD instruction

Controller application workspace

Rockwell Automation, Inc.

The controller application workspace is the main area where you view, configure, monitor, and
troubleshoot Micro800 controllers in a FactoryTalk Design Workbench project.

The controller application workspace contains the Controller tree and controller configuration

pages.
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Figure 8. Controller tree and the General configuration page of an Micro870 L70E controller

MyController, 2080-L70E-24QWBN

Controller

General

Memory Name

MyControll
Startup/Faults yiontrofier
Serial Port

Description
USB Port
Ethernet

Modbus Mapping

Vendor name

MicroLogix Mapping

Allen-Bradley
Real-Time Clock
Remote LCD Catalog ID
Data Log 2080-L70E-24QWBN
Recipe

Product lifecycle

@ Active

Revision

23

Download source code @

@ Yes

Controller tree
The Controller tree lists the available configurations for a Micro800 controller.

The nodes in the Controller tree vary with the controller type. The following table lists the nodes
in the Controller tree.

Table 14. Items in the Controller tree

Node Available for

General Al

Memory All

Startup/Fault All

Serial Port Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
USB Port Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
Ethernet Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
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Online center
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Table 14. Items in the Controller tree (continued)

Node Available for
Modbus Mapping Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
MicroLogix Mapping Micro850 L50E and Micro870 L70E controllers

Real Time Clock

Al

Motion 2080-L50E-xx0BB, 2080-L50E-xxQVB, and 2080-L70E-xxQBB(N) controllers
Remote LCD Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
LCD Module Micro810 LC10 controllers
Data Log Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers
»  When an SD card is added, the data logs displayed after selecting Manage data
log are loaded from the SD card.
»  When an SD card is not added, the data logs displayed after selecting Manage
data log are loaded from the computer.
Recipe Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers

The Manage recipe function is available when an SD card is added to the controller.

Controller configuration page

The content on the controller configuration pages varies with the controller type and the tree
node that you selected. Use the controller configuration page to:
 View and configure the relevant settings of the current controller.

* Resize the page.

The Online center contains information on the added devices and the options to control the
devices and configure the online settings:

 The name, catalog number, and connection path of the added devices.

e The Download and Uplead button.

» The messages about the download and upload progress.

» Alink to the Online settings on page 30 page.

Use the Online center to:
+ Download device configurations.

» Upload device configurations.

» View the download and upload progress.

» Change the device connection path.

«  Open Online settings to view and change the online settings on page 30.

FTDW-GROOTB-EN-P - April 2026
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Figure 9. Online center

o (5 o

1 selected Online settings

Device

Path

[ Download H Upload

Progress

@ | 10.224.120.19%4

Table 15. Items in the Online center

Item

Description

Shows how many devices are selected in Online center.

Opens the Online settings on page 30 page to configure relevant settings.

1
(2
©

Indicates the device connection status.
»  Gray: The device is offline.
< Green: The device is online.

e Red: The device is offline and has faults.

Opens the Select device dialog to select a device to connect to.

Opens the Download device dialog to download the selected device configurations to the
device.

Opens the Upload device dialog to upload the selected device configurations to FactoryTalk
Design Workbench for editing.

Lists the added devices with the device names and catalog numbers.

09 6 00

Displays the device connection paths.
To change the connection path, do one of the following:
« Double-click the Path box, and then enter the path.

e Select E, and then in Select device, enter a path.

o

Displays the status and time stamps of the actions that are performed on the added
devices.

Online settings

Use the Online settings dialog to configure the controller's settings for communication,
downloading, uploading, and device discovery.

30
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Table 16. Controller online settings

Description

Determines whether to use the cellular network for downloading and
uploading.
The default setting is No.

Sets the controller mode when downloading is completed.
The default setting is Remote program.

Category Setting
General Use Cellular Network
Download Mode

Connection

Determines whether to connect to the controller when downloading is
completed.
The default setting is Connect.

Project value

Determines whether to download the values of the variables.
The default setting is No.

Warning

Determines whether to download the controller project that contains
build errors.
The default setting is Yes.

Communication

Determines whether to download the project when the driver settings
for Ethernet, USB, or DF1 differ in the controller and the project.

The controller cannot automatically establish a connection if you
download mismatched configurations between the controller and the
project.

The default setting for Download Ethernet is No.

The setting is applicable when using the same driver to download the
corresponding driver settings for Ethernet, USB, or DF1.

The default setting for Download Ethernet, Download USB, or
Download Serial Port is No.

Upload Connection

Determines whether to connect to the controller when uploading is
completed.
The default setting is Connect.

Project value

Determines whether to upload the values of variables.
The default setting is No.

Discover Discover

Determines whether to connect to the controller and initiate debugging
when discovery is completed.
The default setting is Connect.

Rockwell Automation, Inc. FTDW-GROOTB-EN-P - April 2026 31



Projects

Chapter 2

A FactoryTalk Design Workbench project contains different components that you use to design,
configure, program, visualize, and maintain your devices.

A FactoryTalk Design Workbench project contains the following key elements:

Controller programs with the main logic for the project, executing a set of instructions
+ Configuration settings for controllers, drives, I/0s, and project-specific settings

 Variables that are both global and local

» User-defined date types, including arrays, structures, and defined words

Device and project compatibility

FactoryTalk Design Workbench supports devices from different releases. To use projects or
devices from different releases, beware of the compatibility between releases.

Table 17. Compatibility between a FactoryTalk Design Workbench release and Micro800 controller

firmware revision

FactoryTalk Design
Workbench Release

Micro800 Firmware Revision

1.01.00

*  Micro810 LC10 controllers: 7.x
*  Micro820 L20E, Micro850 L50E, or Micro870 L70E controllers: 23.xx and 22.xx

1.00.00

Micro810 LC10 controllers: 7.x
*  Micro820 L20E, Micro850 L50E, or Micro870 L70E controllers: 23.xx and 22.xx

Table 18. Compatibility mechanism for earlier software versions

Controller Project

Controller Firmware

Version Revision

Create R23.00 or R22.00 for Project can be downloaded | R23.00 or R22.00 for
Micro820 L20E, Micro850 | into Micro820 L20E, Micro850
L50E, and Micro870 L70E L50E, and Micro870 L70E
controllers controllers
R7.00 for Micro810 LC10 R7.00 for Micro810 LC10
controllers controllers

Import R23.00 or R22.00 for Project can be downloaded | R23.00 or R22.00 for

Micro820 L20E, Micro850
L50E, and Micro870 L70E
controllers

into

Micro820 L20E, Micro850
L50E, and Micro870 L70E
controllers

R7.00 for Micro810 LC10 R7.00 for Micro810 LC10
controllers controllers
Upload or discover R23.00 or R22.00 for Project can be downloaded | R23.00 or R22.00 for

Micro820 L20E, Micro850

into

Micro820 L20E, Micro850
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Table 18. Compatibility mechanism for earlier software versions (continued)

Controller Project Controller Firmware
Version Revision

L50E, and Micro870 L70E L50E, and Micro870 L70E
controllers controllers

R7.00 for Micro810 LC10 R7.00 for Micro810 LC10
controllers controllers

Create a project

Use the Welcome page or the File menu to create a project. Upon project creation, a directory
structure is generated, and the project is saved at the Documents folder.

Project naming conventions are as follows:
 The project name can contain up to 40 characters.
 The project name is restricted to alphanumeric characters and underscores.
» The project name cannot end with an underscore or contain consecutive underscores.

» The project name cannot be reserved words for Windows or Disk Operating System, such

non non non

as "nul", "aux’, "con", "com?1", and "Ipt1".

Prerequisites

» Close any open projects.

To create a project

1. Open New project by doing one of the following:
- From the Welcome page, select New project.

- From the menu bar, select File > New project.

2. In New project, enter the project name, and then select Create.

Because Add device on creation is selected by default, Add device opens after project
creation. If you do not want to add a device when creating the project, clear Add device on
creation.

3. (optional) Add a device to the project:
a. In Add device, select a controller.
b. (optional) In Selection, enter the device name, select the device revision, view the
device product lifecycle information, and then select Add.

Manage devices

Use Project Organizer to add, rename, or delete devices in FactoryTalk Design Workbench.
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Controllers catalog

34

Table 19. Micro800 controller specifications

Every controller in the catalog has a unique catalog ID that is related to its device properties
and specifications.

. Number of
Digital 1/0 Number of
Catalog Number . Outputs and Input Power
points Inputs and Type
Type
Micro810® LC10 controllers
2080-LC10-12AWA 12 8-120/240 VAC | 4-Relay 120/240 V AC
2080-LC10-12DWD 12 8 total 4-Relay 12VDC
4-12VDC
4-AINC-10V
2080-LC10-1208B 12 8 total 4-Source 24V DC
4-24VDC
4-AINC-10V
2080-LC10-120WB 12 8 total 4-Relay 24V DC
4-24V DC
4-AINC-10V
Micro820® L20E controllers
2080-L20E-20AWB(R) 20 12 total 7-Relay 120 VAC
8-120V AC T-Analog
4-Analog
2080-L20E-200BB(R) 20 12 total 7-DC FET 24V DC
8-24V DC 1-Analog
Sink/Source
4-DC/Analog
2080-L20E-20QWB(R) 20 12 total 7-Relay 24V DC
8-24VDC 1-Analog
Sink/Source
4-DC/Analog
Micro850® L50E controllers
2080-L50E-24AWB 24 14-24 V DC/V AC | 10-Relay 24V DC
Supports DF1
2080-L50E-240BB 24 14-24V DC/V AC | 10-Source 24V DC
Supports DF1
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Add a controller to the project

Rockwell Automation, Inc.

Table 19. Micro800 controller specifications (continued)

Number of

Digital I/0 Number of umaero
Catalog Number . Outputs and Input Power

points Inputs and Type

Type

2080-L50E-240VB 24 14-24V DC/V AC | 10-Sink 24V DC
Supports DF1
2080-L50E-24Q0WB 24 14-24V DC/V AC | 10-Relay 24V DC
Supports DF1
2080-L50E-48AWB 48 28-110V AC 20-Relay 24V DC
Supports DF1
2080-L50E-480BB 48 28-24V DC/V AC | 20-Source 24V DC
Supports DF1
2080-L50E-480VB 48 28-24V DC/V AC | 20-Sink 24V DC
Supports DF1
2080-L50E-480WB 48 28-24V DC/V AC | 20-Relay 24V DC
Supports DF1
Micro870® L70E controllers
2080-L70E-24AWB 24 14-24V DC/V AC | 10-Relay 24V DC
Supports DF1
2080-L70E-2408BB 24 14-24V DC/V AC | 10-Source 24V DC
Supports DF1
2080-L70E-240BBN 24 14-24V DC/V AC | 10-Source 24V DC
Supports DF1 and DNP3
2080-L70E-240WB 24 14-24V DC/V AC | 10-Relay 24V DC
Supports DF1
2080-L70E-240WBN 24 14-24V DC/V AC | 10-Relay 24V DC

Supports DF1 and DNP3

Use Add device to add a controller to a FactoryTalk Design Workbench project. FactoryTalk
Design Workbench supports one controller for each project.

After selecting a controller, in the Selection pane of the Add device dialog, the following

controller information is shown:

» Catalog ID

Controller name for entry
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»  Controller revision
» Product lifecycle information on page 126

For more information about devices, see Controllers catalog on page 34.

Prerequisites
 Create a project without adding a controller.

To add a device to a project

1. Open Add device by doing one of the following:
- In Project Organizer, right-click a blank space, and then select New device.
- InProject Organizer, select the New device button.

2. In Add device, double-click the controller you want to add or select the checkbox
beside the controller.

3. In Selection, enter the controller name, select the contraller revision, view the
controller lifecycle information, and then select Add.
After adding a controller, it is recommended that you secure the controller with a
password on page 37. Be sure to record and store the password securely, because it
cannot be recovered if lost.

Discover and add a controller connected to a computer

Use the discover device function to view and add the devices connected to a computer. You can
use the function to:

» Replace the existing controller in the controller project with the discovered one.

» Add a controller and its controller project to an empty project.

Prerequisites

» The controller is offline.

To discover and add a controller connected to a computer

1. Open Select device by doing one of the following:
- InProject Organizer, select B,

- In Project Organizer, select Discover device.
- InProject Organizer, right-click a blank space, and then select Discover device.
- Open Add device on page 35, and then select Discover device.
2. If connecting to the device via Ethernet, in Select device, select 4 ,and then in
Configure Driver, select Add New, enter the IP address of the device, and select OK.
3. In Configure Driver, select Close.
4. In Select device, select the node that contains the device to refresh the device list.
b.  Select the device, and then select OK.
The device is added to the project and Project Organizer. An upload is then performed
automatically, and the controller will be connected.
6. (optional) If you've already added a controller to the project and are selecting another
controller from Select device, Discover controller opens, asking if you want to
replace the existing controller with the selected one. Select Replace.
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Secure a controller with a password
To prevent unauthorized access to the configuration and programming in a controller, it is
recommended that you secure the controller with a password.
When a controller is configured with a password, you must enter the password before doing any
of the following:
+ Connect to the controller on page 37.
» Change the controller password on page 38.
 Clear the controller password on page 38.

IMPORTANT: If the existing password is forgotten or lost, it cannot be recovered, changed, or cleared. If a
controller fault occurs during password configuration, restart the controller and reconfigure the password.

Prerequisites
 The controller is in Remote program mode.

To secure a controller with a password

1. Open Change password for <controller-name> by doing one of the following:
- In Connection, select Secure, and then select Set password.
- InProject Organizer, right-click the controller, and then select Secure > Set

Password.
- In Project Organizer, select the controller, and then from the menu bar, select

Device > Secure.

2. In Change password for <project-name>, enter a password. Passwords must be 8
to 64 characters long, which can include letters, numbers, spaces, and any keyboard
symbols.

3. In Confirmation, enter the exact password again.

(optional) To view the password, select .

5. Select OK.

&

Connect to a password-protected controller
You must have the password before connecting to a password-protected controller.

Micro800 controllers allow the connection of one configuration tool at a time. You cannot
connect to the controller when:

 The controller is locked by another user.
» The type of the selected controller does not match the one defined in the opened project.

To connect to a password-protected controller

1. From the menu bar, select 5 to open Online center.

2. InOnline center, do one of the following:
- In the Path column, enter the controller connection path.

- Select = to open Select device, find and select the controller, and then select

OK.
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3. Connect to the controller by doing one of the following:

- In Connection, turn on the toggle beside the Micro800 controller.

- InProject Organizer, right-click the controller, and then select Connect.
4. In Enter password, enter the controller password, and then select OK.

IMPORTANT: The controller will enter the locked-out state after a total of T or more unsuccessful
password attempts, whether consecutive or spread out over time. In the locked-out state, the following
conditions apply:
- Asubsequent attempt with the correct password will only succeed after 300 seconds (locked-out
duration).
- If you do not make subsequent attempts, the controller will automatically reset the unsuccessful
sign-in count and exit the locked-out state after one day (auto unlock duration).

Change the controller password

Before changing the controller password, you must have the current password.

IMPORTANT: If the existing password is forgotten or lost, there is no way to recaver or change the password.

We recommend changing the controller password periodically to protect the programs and
functions in the controller.

Passwords must be 8 to 64 characters long, which can include letters, numbers, spaces, and any
keyboard symbols.

Prerequisites

 The controller is in Remote program mode.

To change the controller password

1. Open Change password for <controller-name> by doing one of the following:
- In Connection, select Secure, and then select Change password.
- In Project Organizer, right-click the controller, and then select Secure > Change
Password.
- In Project Organizer, select the controller, and then from the menu bar, select
Device > Secure > Change password.
2. InChange password for <controller-name>, do the following:
a.  Enter your current password.
b.  Enter your new password.
c.  Enter your new password again to confirm it.

To view the password, select .
3. Select OK.

Clear the controller password

38

Before clearing the password for a Micro800 controller, you must have the current password.

Prerequisites

* The controller is in Remote program mode.
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To clear the controller password

1. Open Clear password for <controller-name> by doing one of the following:
- In Connection, select Secure, and then select Clear password.
- In Project Organizer, right-click the controller node, and then select Secure >
Clear Password.
- InProject Organizer, select the controller, and then from the menu bar, select
Device > Secure > Clear password.
2. InClear password for <controller-name>, enter the password.
To view the password, select <.

3. Select OK.

Data protection

Use Data protection to create multiple user-defined global variables that retain their values
when:

* Restoring a controller project from a memory module (available for Micro820 L20E,
Micro850 L50E, and Micro870 L70E controllers).

» Downloading a project, programs, variables, and controller configurations to a Micro800
controller (available for Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers).

In FactoryTalk Design Workbench, the variables that are defined for data protection retain their
values if the project stored in the memory module and the current controller project meet the
following criteria:

* The variable name, data type, and number of bytes are defined the same in both projects.
» The arrays and array dimensions are defined the same in both projects.

+ The variable is configured with data protection in both projects.

Table 20. Information in the data protection grid

Column Description

No. Displays the index number of the variable. Deleting a variable causes the indexes of all
the subsequent variables to decrement by one.

Up to 60 global variables are supported for data protection.

Variable Name Displays the user-defined variable name.

Data Type Displays the data type of the global variable.
Supported data types are:

BOOL, BYTE, DATE, DINT, DWORD, INT, LINT, LREAL, LWORD, REAL, SINT, TIME, UDINT,
UINT, ULINT, USINT, WORD, and USER ARRAYS.

Rockwell Automation, Inc. FTDW-GROOTB-EN-P - April 2026 39



Chapter2  Projects

Add variables for data protection

Use Data protection to select multiple user-defined global variables that retain their values
when:

* Restoring a controller project from a memory module (available for Micro820 L20E,
Micro850 L50E, and Micro870 L70E controllers).

» Downloading a project, programs, variables, and controller configurations to a Micro800
controller (available for Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers).

Data protection supports up to 60 user-defined variables of the following types:
 Simple data types, excluding STRING

 Arrays with up to three dimensions

To add variables for data protection

1. Open Data protection by doing one of the following:
- InProject Organizer, right-click the controller, and then select Data Protection.
- In Project Organizer, select the controller, and then from the menu bar, select
Device > Data protection.
2. In Data protection, double-click Select variable or select "*".
In the variable selector, find and select the variable, and then select Select.

4. In Data protection, select OK.
To delete a variable from Data protection, right-click the variable, and then select

Delete.

o~

Change the Micro800 controller project

Use Change controller to change the controller type on page 42 or update the controller with
the latest controller revision.

IMPORTANT: Because Micro800 controllers support different hardware and software functions, changing the
controller might require modifications to the following:

»  Controller configurations

»  Programs

»  User-defined function blocks

»  User-defined functions

«  Global or local variables
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Figure 10. Change controller dialog

-
Change controller *
A, Changing the controller type will modify, delete, and invalidate configurations incompatible with the
target controller.
Current Target
o Name M870E M870E
e Catalog ID 2080-L70E-24QWB 2080-L50E-48AWB v
o Revision 23 23
~—| = Comparison details
Property Current Target
Family Micro870 Micro850
Embedded input 14 28
m-( Embedded output 10 20
A Memory 28586 steps / 686080 by.. 13653 steps / 327680 by...
A HSC 4 N/A
Feedback maotion 3 4
- Plug-in module 3 5
o— Back up current project
Help B | cencel |

Table 21. Change controller dialog

Item Name Current

Target

o Name The name of the current Micro800
controller that you entered when
adding the controller.

The name is read-only.

The name of the target Micro800
controller.

The default name of the target
controller is the current controller's
name.

Enter a name for the target
controller if needed.

e Catalog ID The catalog number of the current
Micro800 controller.

The catalog numbers of the
controllers that can be selected as
the target controller.

9 Revision The controller revision of the current
controller project.

The revision is read-only.

The latest controller revision of the
selected target controller.

The revision is read-only.
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Table 21. Change controller dialog (continued)

Item Name Current Target
1 Comparison details | Alist of properties compared between the current controller and the target
controller.

Select ® to show or hide the comparison details.

A indicates a reduction in capacity to the physical configuration of the
project or a supported function. Hover over A to view the details and

recommended actions.

o Back up current A checkbox that determines whether to back up the current controller
project project. When selected, the current controller project is backed up at the
FTDW folder within Documents.

The checkbox is selected by default.

Change the Micro800 controller type

42

Change the controller type to save the current controller project and create another controller
project based on the target controller type. FactoryTalk Design Workbench creates the project
with the latest firmware revision of the target controller.

When changing the controller type, the following components are copied to the target controller
project:

 Controller configurations

* Programs

User-defined function blocks
* Global and local variables

» User-defined data types

The default location for saving the controller project and backing up the original controller
project is the FTDW folder within Documents.

Prerequisites

» The controller is offline.
» The controller is not a Micro810 LC10 controller.

To change the Micro800 controller type

1. Open Change controller by doing one of the following:
- In Project Organizer, select the controller, and then from the Device menu, select
Change controller.
- In Project Organizer, right-click the controller, and then select Change
Controller.
2. From the Catalog ID list, select the target controller.
(optional) In the Name box, enter the controller name.
4. Select » to show the comparison details between the current and target controllers.

[
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Build a project and view outputs

Set up the connection path

Rockwell Automation, Inc.

5. (optional) Hover over A to show the potential impacts of changing to the target
controller, and then take the recommended actions as needed.

A\ indicates a reduction in capacity to the physical configuration of the project or a

supported function.

6. (optional) Select Back up current project to back up the original project to your

computer.
1. Select OK.

FactoryTalk Design Workbench builds the entire project before you download the program to the
Micro800 controller. After the initial build, FactoryTalk Design Workbench decides whether to
rebuild the entire project or only the components that have changed since the last build before
downloading.

We recommend that you manually build the project before downloading to find and resolve any
errors.

Prerequisites

» Save the project.
» No download operation is in process.

To build a project and view outputs

1. Build the project by doing one of the following:
- InProject Organizer, right-click the controller node, and then select Build.
- In Project Organizer, select the controller node, and then from the menu bar,
select Device > Build.
- On the controller memory configuration page, select Build.
- In Project Organizer, right-click an individual Program Organization Unit, and
then select Verify Program.
2. Inthe Output pane, on the Log page, monitor the building progress and identify build
errors. If the project has build errors:
a. Inthe Output pane, on the Error list page, view and resolve any build errors.
b.  Clean the build errors by doing one of the following, and then build again:
- InProject Organizer, right-click the controller node, and then select Clean.

- From the menu bar, select Device > Clean.

Use Online center to set up the connection path for the controller by entering its IP address.

To set up the connection path

1. Select B to open Online center.
2. In Online center, in the Path box, enter the IP address of the controller.

3. Select Enter.
To clear the connection path, double-click the Path box, delete the IP address, and then select

Enter.
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Add a serial-DF1 driver

Configure a serial-DF1 driver to establish RS-232 communication with Micro800 controllers.
Each project supports one serial-DF1 driver.

IMPORTANT: Unlike Connected Components Workbench, which automatically adds a DF1 driver after you plug in the
DF1 device, FactoryTalk Design Workbench requires you to manually add and configure a DF1 driver before:
»  Connecting to a Micro810 LC10 controller.
»  Connecting to a Micro820 L20E, Micro850 L50E, or Micro870 L70E controller via a USB device on a remote
LCD module.

Prerequisites
» Acontroller is added to your project.

» CIP serial is set as the driver for the serial port settings.

To add a DF1 driver
1. Select & to open Online center.
2. In Online center, select ~ .
3. In Select device, select L3
4. In Configure Drives, from the Available Driver Types list, select R$-232 DF1, and then

select Add New.
5. In Configure RS-232 DF1 driver, enter the settings.
- To connect to a Micro820 L20E, Micro850 L50E, or Micro870 L70E controller, the
following settings must be correctly configured:

Table 22. Micro820 L20E, Micro850 L50E, and Micro870 L70E controller DF1 driver

configuration
Via a DF1 device Via a USB device on a remote LCD module
COM Port COM Port

Baud rate: must be the same as that on the
Serial Port configuration page

Error check: CRC

Error check:must be the same as that on the
Serial Port configuration page

Baud rate: 38400

Protocol: must be the same as that on the
Serial Port configuration page

Parity: None

Station number: must be the same as
the Station address on the Serial Port
configuration page

Station address: 1

Parity: must be the same as that on the Serial
Port configuration page

- To connect to a Micro810 LC10 device, the following settings must be correctly
configured:
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Table 23. Micro810 LC10 DF1 driver configuration

Setting Value

COM Port Specify the port number.
Baud rate 57600

Error check CRC

Protocol Full Duplex

Station number 1

6. Select Test configuration to test the settings. Before testing, ensure that your DF1
device is connected.
If the test fails, possible reasons include:
- The COM port is used by RSLinx® Classic or FactoryTalk® Linx.

- CIP serial is not set as the driver.
- The driver configuration does not match the connected driver.

Adjust the settings to resolve the configuration issues.
1. Select OK.

Serial-DF1 properties

The Configure RS-232 DF1 driver dialog contains the following information.

Table 24. Serial-DF1 properties

Setting Description

Driver name Specifies the name of the serial driver. If changed, the name must be unigue across
the entire topology and cannot exceed 255 characters.

COM Port Lists the available COM ports on your computer. The driver transmits data to a device
connected to the serial (COM) port of a computer. Select a port from the list. Available
port numbers are from 0 through 31 (default is 1).

Device Shows the DF1 device that is connected with your computer.

Baud rate Specifies the baud rate for the driver that transmits data to your device. Available
baud rates are 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200. The
default is 19200.

Station number Specifies the station number for the driver. Available station numbers are from 0
through 254 decimal (default is 0).

Parity Matches the error-checking method for the connected driver (None, Even, or 0dd).

Error check Matches the setting of the device you are connected to (BCC or CRC). All devices on
the network must be configured the same.

Stop bits Specifies the amount of time between data transmissions. Basic DF1 protocol
generally uses 1(default is 1).

Protocol Specifies the supported protocols (Full Duplex or Half Duplex).

Ack/poll timeout Specifies the ACK value. The default is 3000 milliseconds.
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Table 24. Serial-DF1 properties (continued)

Setting Description

Maximum retries Specifies a value for the maximum number of times the system should retry. The
default is 3.

Test configuration Tests if the driver configuration is correct. Before testing, ensure that your DF1 device
is connected.

If the test fails, possible reasons include:

+  The COM port is in use by RSLinx Classic or FactoryTalk® Linx.
+  CIP serial is not set as the driver.
« The driver configuration does not match the connected driver.

Connect to a Micro800 controller

46

After adding a Micro800 controller to your project, connect to the controller, and then proceed
to diagnose or secure the controller.

If no Micro800 controller exists in your project, use Discover and add a controller connected to a
computer on page 36 to discover and connect to a Micro800 controller.

IMPORTANT: When your computer is connected to a Micro800 controller, other users who are trying to connect to
the controller will be informed that the controller is in use. The notification will display your computer name and
username.

To connect to a Micro800 controller

1.

Open Online center by doing one of the following:
- Select 5.
- InProject Organizer, right-click the controller node, and then select Download.

In Online center, select =. = is available when the controller is disconnected.
In Select device, find and select the Micro800 controller, and then select OK.

Q - Selecting a controller with a different catalog number than the controller defined in the
project will lead to a connection failure.

- Once selected, the connection path is displayed in Online center. You can also manually
set up the connection path on page 43.

Connect to the controller by doing one of the following:

- In Connection, turn on the toggle beside the controller.

- In Project Organizer, right-click the controller node, and then select Connect.
(optional) In Enter password, enter the controller password, and then select OK.
(optional) In Connect controller, select one of the following:

- Download current project to the controller

- Upload current project from the controller
Connect controller opens when the content in the current project does not match the
content in the controller.

IMPORTANT: We recommend disconnecting from the controller when not in use to prevent connection
loss due to the computer entering sleep mode.
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Download a controller configuration to a controller

Use Download device to download a project from FactoryTalk Design Workbench to a Micro800
controller for running and testing. The project can contain programs, variables, and controller
configurations.

When downloading the project, if the controller revision doesn't match the one defined in the
FactoryTalk Design Workbench project, the Update and download dialog opens. Use the dialog
to update the controller revision, and then download the project again.

When the download begins, FactoryTalk Design Workbench performs the following tasks:
*  Builds any unbuilt programs.
»  Compares the configuration of the connected controller with the project configuration.
 Downloads the project, programs, variables, and controller configuration to the controller.

If an error occurs when performing any of the tasks, the download is canceled, and the
controller remains unchanged.

If the initial value for the variable is set to the default value for the data type, such as 0, 0.0,
D#1970-01-01, FactoryTalk Design Workbench initializes the variable with its value.

Q When initializing variables with project values, the following conditions apply:
Variables with a Direction of Varlnput cannot be downloaded.
«  Variables with an Attribute of Read or No Access cannot be downloaded.
»  Complex variables, such as structures and arrays that contain members with initial values,
cannot be downloaded.
Variables with both a value and an initial value will be initialized with their initial value.

Prerequisites

 Set the connection path for the controller.

 The catalog number of the controller in the current project matches the one you're
downloading to.

To download a controller configuration to a controller

1. Select B to open Online center.

2. From the Device list, select the controller, and then select Download.

3. In Download device, select OK.

4, Use the Output pane to view the result.

5. (optional) Resolve any errors, and then download the configuration again.

Upload a controller configuration from a controller

Rockwell Automation, Inc.

Use Upload device to upload a project containing programs, variables, and controller
configurations from a Micro800 controller to FactoryTalk Design Workbench. All project
programs, variables, and controller configurations are overwritten after an upload. Once the
project is uploaded to FactoryTalk Design Workbench, you can edit the controller project, and
then download it back to the controller.
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Prerequisites

« Set the connection path for the controller.

 The catalog number of the controller in the current project matches the one you're
uploading from.

To upload a controller configuration from a controller

1. Select B to open Online center.
2. In Online center, from the Device list, select the controller, and then select Upload.
3. In Upload device, select OK.

Q COP instruction blocks do not upload values for Src and Dest variables. Other instruction
blocks and variables are not affected.

4, Use the Output pane to view the result.
h. If there are errors, resolve them, and then upload again.

Monitor local and global variables

Open the local or global variable grids to monitor the variable values in real time.

Each variable grid displays the values and force status of the variables in their respective
columns. When the output value is not available, text appears in the output label.

For graphical programs and function blocks, the appearance of values vary with their type:

+ Boolean data type output values are displayed in either black or gray, regardless of
whether the value is True or False. A black output value indicates that it can be modified,
and a gray output value indicates that it cannot be changed.

Qutput values of the SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, LINT, ULINT,
LWORD, REAL, LREAL, TIME, DATE, and STRING data types appear as a number or text value
in the element. When the output is a structure type, the value appears as the selected
member.

Prerequisites

» The controller is in Remote run mode.

To monitor local and global variables

1. Open the variable grid by doing one of the following:
- To open the local variable grid, in Project Organizer, go to Programs >
<program-name>, and then double-click Local Variables.
- To open the global variable grid, in Project Organizer, double-click Global
Variables.
2. Monitor the values.

Q - The background color of a cell shows its status: white for modifiable; gray for read-only.
- The Value of user-defined functions and user-defined function blocks are read-only.

- For Program Organization Units whose Value is modifiable, you can also modify the
value in the language editor.
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View the controller mode

When connected to a Micro800 controller, use Connection to view the controller mode.

Prerequisites

» The controller is online.

To view the controller mode

In Connection, select ” to expand the controller information. Available controller

modes are as follows:

- Program: The controller is in the non-running mode and can be programmed. The
mode cannot be changed remotely.

- Remote program: The controller is in the non-running mode and can be
programmed. The mode can be changed remotely.

- Run: The controller is in the running mode. The mode cannot be changed
remotely.

- Remote run: The controller is in the remote running mode, displaying the
connected values from the controller in FactoryTalk Design Workbench. The mode
can be changed remotely.

Change the Micro800 controller Remote mode

When connected to a Micro800 controller, use Connection to change from Remote to Program
or Run mode.

O »  For Micro850 L50E controllers, the toggle on the controller must be in the Remete center position
to make the Remote program and Remote run options available.
»  Micro810 LC10 and Micro820 L20E controllers do not have a toggle and are always in Remote
mode.

Prerequisites

» The controller is online.

To change the Micro800 controller Remote mode

1. In Connection, select
2. From the Controller mode list, select Program or Run.

View the controller fault status

When connected to the Micro800 controller, use Connection to view the controller fault status.

Prerequisites

» The controller is online.
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To view the controller fault status
1. (optional) If Connection is hidden, open it by doing one of the following:
- From the View menu, select Connection.
- Select 5 to open the Online center.

2. In Connection, beside the controller name and catalog number, check the color of the
toggle. If a fault occurs, the toggle turns red with an error icon.

Monitor and diagnose a Micro800 controller

Open the diagnostics pages

50

FactoryTalk Design Workbench supports diagnostics for network connectivity, controller startup
settings, controller faults, and controller projects stored in memory. Controller diagnostics are
available when the controller is online.

To monitor and diagnose a Micro800 controller, use the Device menu, the Diagnose button in
Connection, or the following controller configuration pages:

« Startup (Micro810 LC10 controllers)
+ Startup/Faults

 Serial Port

» Ethernet

«  Memory Card

«  LCD Module (Micro810 LC10 controllers)
*  Plug-in Modules - 2080-SERIALISOL

*  Plug-in Modules - 2080-MEMBAK-RTC2
*  Plug-in Modules - 2080-DNET20

Use the Device menu, the Connection pane, or one of the controller configuration pages to
open the controller diagnostics pages.

Prerequisites

» The controller is online.

To open the diagnostics pages

Do one of the following:
- InConnection, select ™ to expand the controller information, and then select

Diagnose.
- In Project Organizer, select the controller, and then from the Device menu, select
Diagnose.
- From one of the following pages, select Diagnose:
- Startup (Micro810 LC10 controllers)
- Startup/Faults
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- Serial Port

- Ethernet

- Memory Card

- LCD Module (Micro810 LC10 controllers)
- Plug-in Modules - 2080-SERIALISOL

- Plug-in Modules - 2080-MEMBAK-RTC2
- Plug-in Modules - 2080-DNET20

Disconnect from a Micro800 controller
Disconnect from a controller to:
Configure the Micro800 controller properties.

e Add plug-in modules on page 90.

» Update programs on page 80.

To disconnect from a Micro800 controller

Do one of the following:
- InProject Organizer, right-click the controller, and then select Disconnect.
- In Connection, turn off the toggle beside the controller.

Fault diagnostics

Use the <controller-name>: Fault view to:

 View information on any faults that occurred.

* Retrieve a detailed fault log or core dump file from the controller.

Clear a fault.
The <controller-name>: Fault view shows the last seven recoverable and the last seven non-
recoverable faults with:

 The fault code

 Fault location and the link if available

» Adescription of the fault

The <controller-name>: Fault view is available by selecting the Fault button from the
Connection pane when the controller is in Remote run mode.

Figure 11. Controller Fault view

@ Clear fault @ Get fault log

Recoverable Fault

Index Fault Code Location Description

1 OxFOE3 M/A The configuration of the plug-in module on slot 3 does not match the actual plu
Mon-recoverable Fault

Index Fault Code Location Description
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Table 25. Fault Diagnostics view items and descriptions

Item

Description

Clear fault

Deletes the faults and fault logs from the controller.

Get fault log

Retrieves the detailed faults and fault logs from the controller. The information can be
used when seeking technical support.

By default, the fault log is saved as a TXT file in the Downloads folder. You can customize
the path as needed.

Get core dump fault
log

Retrieves the core dump of Micro800 controller to a Bin file, which you can send to the
Rockwell Automation engineering team for troubleshooting and debugging.

By default, the core dump is stored with the name
Controller_Core_Dump_mm_dd_yyyy_hh_min_sec.bin in the Downloads folder.

You can customize the path as needed.

The size limit for the core dump is 8,192 bytes. Upgrading the firmware clears the core
dump.

Recoverable/Non-reco
verable Fault

Displays two types of faults:

» Recoverable faults are the faults that can be cleared without having to power cycle
the controller.

« Non-recoverable faults are the faults that require the controller to be power cycled
before clearing the fault.
Up to the last seven faults are recorded for each type of fault with the latest fault
shown at the top. If more than seven faults occur, the oldest faults are overwritten.

Index

Displays the sequential number of the faults. The index number 1indicates the last fault.

Fault Code

Displays the fault code in hexadecimal.

Location

Displays the fault location and provides a link to the program, if available.

Description

Displays the information about the fault.

Fault codes and corrective actions

Refer to the following table when clearing a Micro800 controller fault.

Before implementing any of the suggested corrective actions, complete the following steps:

Clear all faults before downloading to the Micro800 controller or upgrading the firmware.

 Turn off the controller before adding or removing plug-in modules.

«  Turn off the Micro800 controller if the red light-emitting diode (LED) is solid red, and then
turn on the controller. If the LED is blinking red, it is not necessary to cycle power.

After taking the corrective action, if the fault persists, contact your Rockwell Automation
technical support at http://rockwellautomation.com/support.

The extended fault code comes from the /0 module itself, not from the controller. Refer to the
I/0 module documentation for an explanation of the extended status code.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

Fault Code Description Corrective Action
0xF000 The controller was unexpectedly reset due to | Do one of the following:
a noisy environment or an internal hardware | | o oo a0 program.
failure. «  Refer to the "Wire your controller”
= AMicro800 controller of revision 2.xx section in your controller's user manual:
attempts to save the program and clear - Micro810 Programmable Controller
the user data. If the system variable User Manual - 2080-UMOO1A-EN-E
-SYSVA_USER_DATA_LOST is set, the - Micro820 Programmable Controller
controller is able to recover the user User Manual - 2080-UM005_-EN-E
program but the user data is cleared. If - Micro830, Micro850, and Micro870
not, the Micro800 controller program is Programmable Controller User
cleared. Manual - 2080-UM002_-EN-E
*  AMicro800 of revision 1.xx clears
the program. The system variable
_SYSVA_USER_DATA_LOST is not
available on Micro800 revision T.xx
controllers.
OxFO1A The controller was unexpectedly reset due | Do one of the following:
to uncommitted changes during Run Mode - Download the program.
Change only. » Refer to the "Wire your controller"
A Micro800 controller of revision 8.xx section in your controller's user manual:
attempts to save the program and clear - Micro810 Programmable Controller
the user data. If the system variable User Manual - 2080-UMOO1A-EN-E
-SYSVA_USER_DATA_LOST is set, the - Micro820 Programmable Controller
controller can recover the user program but User Manual - 2080-UM005_-EN-E
the user data is cleared. If not, the Micro800 - Micro830, Micro850, and Micro870
controller program is cleared. Programmable Controller User
Manual - 2080-UM002_-EN-E
0xFO01 The controller program has been cleared. Do one of the following:
This happened because: - Download the program.
*  Apower-down occurred during program | «  Transfer the program using the memory
download or data transfer from the module restore utility.
memory module.
The cable was removed from the
controller during program download.
»  The RAM integrity test failed.
0xF002 The controller hardware watchdog was Do the following:

activated. The controller hardware watchdog
timeout happens if the program scan is
approximately 3 seconds.

e AMicro800 controller of revision 2.xxx
and later attempts to save the program
and clear the user data. If the system
variable _SYSVA_USER_DATA_LOST is
set, the controller is able to recover

1. Connect to the controller.
2. Download the program.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

the user program but the user data is
cleared.
* A Micro800 controller revision 1.xx

clears the program. The system variable

_SYSVA_USER_DATA_LOST is not
available on Micro800 revision 1.xx
controllers.

0xDOOF

A particular hardware type, for example,
embedded 1/0, was selected in the user
program configuration, but did not match

the actual hardware base.

Do one of the following:

Connect to the hardware that is
specified in the user program.
Reconfigure the program to match the
target hardware type.

0xF003

One of the following occurred:

There is a fault in the memory module.
There is a connection fault for the
memory module.

The memory module was incompatible
with the controller's firmware revision.

Do one of the following:

Remove the memory module and plug it
in again.

Obtain a new memory module.

Upgrade the controller's firmware
revision to be compatible with the
memory module.

For more information on firmware
revision compatibility, go to the
Rockwell Automation Support site and
search for "Firmware Updates".

OxFO04

One of the following occurred:

There is a data transfer error.

There is an embedded RTC data error
(Micro820 L20E only).

There is no user program inside of the
controller.

The memory is full.

For memory module failure, attempt the
data transfer again. If the error persists,
replace the memory module.

For embedded RTC failure, restart the
controller.

For the MicroSD card, use another
MicroSD card or delete files from the
card.

0xF005

The user program failed an integrity check
while the Micro800 controller was in Run

mode.

Do one of the following:

Turn off your controller, and then
download your program and start your
system.
Refer to the "Wire your controller”
section in your controller's user manual:
- Micro810 Programmable Controller
User Manual - 2080-UMOOTF-EN-E
- Micro820 Programmable Controller
User Manual - 2080-UM005_-EN-E
- Micro830, Micro850, and Micro870
Programmable Controllers User
Manual - 2080-UM002_-EN-E
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

0xF006

The user program is incompatible with the
Micro800 controller firmware revision.

Upgrade the controller firmware revision
using ControlFLASH.

For more information on firmware revision
compatibility, go to the Rockwell Automation
Support site and search for "Firmware
Updates".

0xF010

The user program contains an instruction
block that the Micro800 controller does not
support.

Do the following:

1. Modify the program to ensure that all
instruction blocks are supported by the
controller.

2. Build and download the program.

3. Change the controller to Run mode.

OxFO14

An unexpected software fault occurred.

Re-program the memory module. If the fault
persists, replace the memory module.

0xF015

An unexpected software fault occurred.

Do the following:

1. Turn off the controller.

2. Build and download your program, and
then restore any necessary data.

3. Start your system.

If the fault persists, refer to the "Wire your

controller” section in your controller's user

manual:

e Micro810 Programmable Controller User
Manual - 2080-UMO01A-EN-E

+  Micro820 Programmable Controller User
Manual - 2080-UM005_-EN-E

¢ Micro830, Micro850, and Micro870
Programmable Controller User Manual -
2080-UM002_-EN-E

0xF016

An unexpected hardware fault occurred.

Do the following:

1. Turn off the controller.

2. Download the program, and then restore
any necessary data.

3. Start your system.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

If the fault persists, refer to the "Wire your
controller” section in your controller's user
manual:

*  Micro810 Programmable Controller User
Manual - 2080-UMO01A-EN-E

e Micro820 Programmable Controller User
Manual - 2080-UM005_-EN-E

e Micro830, Micro850, and Micro870
Programmable Controller User Manual -
2080-UM002_-EN-E

OxF017

An unexpected software error occurred due
to an unexpected hardware interrupt.

If the system variable
__SYSVA_USER_DATA_LOST is set, the
controller was able to recover the user
program but the user data is cleared. If not,
the Micro800 controller program is cleared.

Do the following:

1. Turn off the controller.

2. Build and download the program, or
clear the controller fault if the user
program still exists.

3. Start your system.

If the fault persists, refer to the wiring

and grounding guidelines for using surge

suppressors in the "Wire your controller”
section of your controller's user manual:

¢ Micro810 Programmable Controller User
Manual - 2080-UMO01A-EN-E

e Micro820 Programmable Controller User
Manual - 2080-UM005_-EN-E

e Micro830, Micro850, and Micro870
Programmable Controller User Manual -
2080-UM002_-EN-E

0xF018

An unexpected software error occurred due
to SPI communication failure.

If the system variable
__SYSVA_USER_DATA_LOST is set, the
controller was able to recover the user
program but the user data is cleared. If not,
the Micro800 controller program is cleared.

Do the following:

1. Turn off the controller.

2. Build and download the program, or
clear the controller fault if the user
program still exists.

3. Start your system.

If the fault persists, refer to the wiring

and grounding guidelines for using surge

suppressors in the "Wire your controller"
section of your controller's user manual:

»  Micro810 Programmable Controller User
Manual - 2080-UMOOTA-EN-E

»  Micro820 Programmable Controller User
Manual - 2080-UM005_-EN-E

e Micro830, Micro850, and Micro870
Programmable Controller User Manual -
2080-UM002_-EN-E
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

0xF019

An unexpected software error occurred
because of a memory or other controller
resource issue.

Do the following:

1. Turn off the controller.

2. Build and download the program.

3. Start your system.

If the fault persists, refer to the wiring
and grounding guidelines for using surge
suppressors in the "Wire your controller"
section of your controller's user manual:

e Micro810 Programmable Controller User
Manual - 2080-UMO01A-EN-E

»  Micro820 Programmable Controller User
Manual - 2080-UM005_-EN-E

*  Micro830, Micro850, and Micro870
Programmable Controller User Manual -
2080-UM002_-EN-E

0xF020

There is a fault in the base hardware or
the hardware is not compatible with the
Micro800 controller firmware revision.

Do one of the following:

1. Upgrade the controller firmware
revision using ControlFLASH.

2. Replace the controller.

For more information on firmware revision

compatibility, go to the Rockwell Automation

Support site and search for "Firmware

Updates".

0xF021

The 1/0 configuration in the user program is
not valid or does not exist in the Micro800
controller. This might happen because there
is no project in the controller or the previous
downloading failed.

Do the following:

—

Verify that you have selected the
correct controller.

Correct the plug-in module
configuration in the user program to
match that of the actual hardware.

3. Comepile and load the program again.
4. Change the controller into Run mode.
If the fault persists, use FactoryTalk Design
Workbench programming software to
develop and download the program.

N

0xF022

The user program in the memory module is
not compatible with the Micro800controller
firmware revision.

Do one of the following:

Use ControlFLASH to upgrade the
controller firmware revision to become
compatible with the memory module.

* Replace the memory module.

For more information on firmware revision

compatibility, go to the Rockwell Automation

Support site and search for "Firmware

Updates".
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

0xF023

The controller program is cleared. This
occurs when:

* A power-down occurred during program
download or data transfer from the
memory module.

«  The Flash Integrity Test failed (Micro810
LC10 only).

Do one of the following:

* Download the program.

 Transfer the program using the memory
module restore utility.

0xF030/0xF031/0xFO
32/0xF033

(Micro820 L20E only)

Power-down information in persistent
memory might not be written properly
because of a noisy environment or an
internal hardware failure.

If the system variable
__SYSVA_USER_DATA_LOST is set, the
controller was able to recover the user
program but the user data is cleared. If not,
the Micro800 controller program is cleared.

Download the program.

0xF050

The embedded 1/0 configuration in the user
program is not valid.

Do the following:

1. Correct the embedded I/0 configuration
in the user program to match that of the
actual hardware.

2. Build and download the program.

3. Change the controller to Run mode

If the fault persists, use the FactoryTalk

Design Workbench programming language to

develop and download the program.

0xF100

There is a general configuration error in the
motion configuration that was downloaded
from FactoryTalk Design Workbench.

Do one of the following:

«  Correct the motion configuration in the
user program.

* If the fault persists, upgrade
FactoryTalk Design Workbench to the
latest version.

0xF10

There is a motion resource error. For
example, the Motion_DIAG variable is not
defined.

Do one of the following:

+  Correct the motion configuration in the
user program.

 If the fault persists, upgrade
FactoryTalk Design Workbench to the
latest version.

0xF12x
x is the axis ID (0-3).

The motion configuration for axis x is

not compatible with the controller, or the
configuration for axis x has a resource
conflict with a previously configured axis.

Do one of the following:

» Delete the axes using FactoryTalk
Design Workbench, and then
reconfigure motion by referencing
Micro830, Micro850, and Micro870
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

Programmable Controller User Manual -
2080-UM002_-EN-E.

* If the fault persists, upgrade
FactoryTalk Design Workbench to the
latest version.

0x15x
where x is the axis ID
(0-3).

There was a motion engine logic error
detected on axis x during a motion engine
cycle operation. This error might indicate a
motion engine data or memory failure.

Do one of the following:

*  Clear the fault, and then change the
controller to Run mode.

 If the fault persists, restart all the
motion components, including
the controller, drive, and moving
mechanism.

»  Download the user program.

0xF210

The expansion 1/0 terminator is missing.

Do the following:

1. Turn off the controller.

2. Attach the expansion I/0 terminator to
the last expansion 1/0 module on the
system.

3. Turn on the controller.

0xF230

The number of expansion power supply
modules has exceeded the upper limit.

Do the following:

1. Turn off the controller.

2. Ensure that the number of expansion
I/0 modules is no more than four.

3. Turn on the controller.

0xF240

The number of expansion 1/0 modules has
exceeded the upper limit.

Do the following:

1. Turn off the controller.

2. Ensure that the number of power supply

modules is no more than four.
3. Turn on the controller

0xF250

There is a nonrecoverable error and one
or more expansion 1/0 modules cannot be
detected.

Restart your contraoller.

0xF300

The memory module/SD card is empty.

Do the following:

1. Ensure that the memory module
contains a valid project.

2. Download the user program and back
up the program to the memory module.

Rockwell Automation, Inc.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)
Fault Code Description Corrective Action
0xF301 The project in the memory module or SD Do the following:
card is not compatible with the project in 1. Ensure that there is a user program
the controller. with a controller that has the correct
controller catalog configured.

2. Download the user program and back

up the program to the memory module
0xF302 The password in the memory module or SD | Do the following:
card does not match the password in the 1. Ensure that the user program in the
contraller. memory module has the correct
password.

2. Download the user program with a
password and back up the program to
the memory module.

3. Use FactoryTalk Design Workbench to
enter the password.

0xF303 The memory module or SD card is not Check to ensure that the memory module is
present. present.
OxF26x The expansion /0 cannot function properly | Restart your controller.

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified.

because the controller cannot start I/0
communications.

0xF27x

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified

A non-recoverable communication fault has
occurred on the expansion 1/0 module.

Restart your controller.

0xF28x

x indicates the
number of the
expansion 1/0.

If x =0, the slot
number cannot be
identified.

The baud rate for the Expansion 1/0 has
caused an error.

Do one of the following:

*  Restart your controller.

 Replace the expansion module in slot
number x.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)
Fault Code Description Corrective Action
0xF29x A fault is detected on the expansion |/0 Do one of the following:

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified.

module.

* Restart your controller.
* Replace the expansion module.

0xF2Ax

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified.

A power failure is detected on the expansion
1/0 module.

Do one of the following:

* Restart your controller.

* Replace the expansion module in slot
number x.

0xF2Bx

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified.

An expansion I/0 configuration fault is
detected.

Do one of the following:

+  Correct the expansion 1/0 module
configuration in the user program to
match the hardware configuration.

e Check the expansion /0 module
operation and condition.

* Restart your controller.

* Replace the expansion module.

OxFFxx

x indicates the
number of the
expansion /0.

If x=0, the slot
number cannot be
identified.

Afault is detected on the expansion I/0
module.

Do the following:

1. Optionally save the fault log from
FactoryTalk Design Workbench.

2. Clear the recoverable fault using

FactoryTalk Design Workbench.

3. If the error resists, contact your local

Rockwell Automation technical support.

0xF0Az (1)

A fault occurred in the plug-in module during
operation.

Do one of the following:

»  Check the condition and operation of
the plug-in module.

* Restart your controller.

If the fault persists, refer to your plug-in

module user manual.

0xFOBz *(1)

The 1/0 module configuration for the
specified plug-in module does not match the
actual plug-in configuration detected.

Do one of the following:

 Correct the individual plug-in module
configuration in the user program to
match that of the actual hardware
configuration.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

Check the condition and operation of
the plug-in module.
Restart your contraoller.

Replace the plug-in module.

If the fault persists, refer to your plug-in
module user manual.

0xFODz X(1)

While power is applied, the plug-in /0
module is removed, plugged out, or a
hardware fault occurred in the plug-in 1/0
module.

Do the following:

1.

Correct the individual plug-in module
configuration in the user program.
Build and download the program using
FactoryTalk Design Workbench.
Change the Micro800 controller to Run
mode.

0xFOEz *(1)

The plug-in I/0 module configuration
does not match the actual detected I/0
configuration.

Do the following:

1.

Correct the plug-in 1/0 module
configuration in the user program.
Build and download the program using
FactoryTalk Design Workbench.
Change the Micro800 controller to Run
mode.

0xDoT

The program scan time exceeded the
watchdog timeout value. The controller
hardware watchdog timeout happens if
the program scan is approximately three
seconds.

Do one of the following:

Determine if the program is caught in a
loop, and then resolve the problem.

Faults might occur if your structured
text program contains a For loop with
the upper limit set to the maximum
value of the variable. For example,
setting the limit of a USINT variable
to 255, or setting the limit of a UINT
variable to 65535.

Use the following steps to correct the

fault:

1. Correct the program to ensure that
the upper limit is not reached. One
method is to use a data type with a
larger maximum value.

2. Build and download the program.

3. Change the controller to Run mode.

If your program is designed to have a

scan time longer than three seconds,

in the user program, increase the

watchdog timeout value that is set in
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

the system variable _SYSVA_TCYWDG,
and then build and download the
program.

0xF830

A fault occurred in the Ell configuration.

Review and change the Ell configuration in
the controller properties.

0xF840

A fault occurred in the HSC configuration.

Review and change the HSC configuration in
the controller properties.

0xF850

A fault occurred in the STI configuration.

Review and change the STI configuration in
the controller properties.

0xF860

A divide by zero error occurred.

Do the following:

1. Correct the program to ensure that
there is no data overflow.

2. Build and download the program using
FactoryTalk Design Workbench.

3. Change the controller to Run mode.

0xF870

An index address was out of the data space.

Do the following:

1. Correct the program to ensure that
there is no index used to access
an array element beyond the array
boundaries.

2. Build and download the program.

3. Change the controller mode to Run
mode.

0xF878

An index used to access a bit is beyond the
boundaries of the data type.

Do the following:

1. Correct the program to ensure that
there is no index used to access a bit
beyond the boundaries of the data type.

2. Build and download the program.

3. Change the controller mode to Run
mode.

0xF880

A data conversion fault occurred.

Do the following:

1. Correct the program to ensure that
there is no data conversion fault.

2. Build and download the program.

3. Change the controller to Run mode.

0xF888

The call stack of the Micro800 controller
cannot support the sequence of calls to the
function blocks in the current project. Too
many function blocks are within another
block.

Change the project to reduce the quantity of
function blocks that are being called within
a block.

Rockwell Automation, Inc.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)

Fault Code

Description

Corrective Action

0xF898

A fault occurred in the plug-in module's user
interrupt configuration or operation.

Correct the plug-in module's user interrupt
configuration to match that of the actual
hardware.

0xFBAO

The TOW parameters are not valid.

Do the following:

 Correct the program to ensure that all
parameters are valid.
+  Build and download the program.

+  Change the controller to Run mode.

OxFBAT

The DOY parameters are not valid.

Do the following:

Correct the program to ensure that all
parameters are valid.

*  Build and download the program.

+ Change the controller to Run mode.

OxF8AL

Afault indicating that there is a
communication loss between the controller
and at least one device when switching to
Run mode.

The extended fault code is 0x0000.

Do the following:

—

On the Ethernet modules on page
95 configuration page, identify the
EtherNet/IP device that shows the
communication-lost error.

2. Resolve the error and clear the
controller fault.
3. Change the controller to Run mode.

OxFFzz *(2)

A user-created fault from FactoryTalk
Design Workbench has occurred.

Do the following:

+ Optionally save the fault log from
FactoryTalk Design Workbench.

+  Clear the recoverable faults using
FactoryTalk Design Workbench.

« If the problem persists, contact
Rockwell Automation technical support
with the fault log.

0xDOOF

A particular hardware type, for example,
embedded 1/0, was selected in the user
program configuration, but did not match
the actual hardware base.

Do the following:

 Correct the program to ensure that all
parameters are valid.

*  Build and download the program.

+ Change the controller to Run mode.

0xDoT

The program scan time exceeded the
watchdog timeout value.

Determine if the program is caught in a loop
and correct the problem.

Faults might occur if your structured text
program contains a For loop with the upper
limit set to the maximum value of the
variable. For example, setting the limit of a
USINT variable to 255, or setting the limit of
a UINT variable to 65535.
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Table 26. Fault codes, descriptions, and corrective actions for a Micro800 controller fault

(continued)
Fault Code Description Corrective Action
Use the following steps to correct the faults:
 Correct the program to ensure that
the upper limit is not reached. One
method is to use a data type with a
larger maximum value.
+  Build and download the program.
+ Change the controller to Run mode.
If your program is designed to have a
scan time longer than three seconds,
in the user program, increase the
watchdog timeout value.
1."Z" indicates the slot number of the plug-in module. If z = 0, then the slot number cannot be identified.

2."zz" indicates the last byte of the program number. Only program numbers up to OxFF can be displayed. For
program numbers from 01x00 through OxFFFF, only the last byte is displayed.

Controller run mode change

Run mode change (RMC) allows specific project changes on page 66 without interrupting
the controller mode. RMC is available for projects using Micro820 L20E, Micro850 L50E, and
Micro870 L70E controllers.

To enter RMC mode, ensure that the controller is in one of the following modes after
downloading, uploading, or discovering a project:

* Remote program

* Remote run. The controller is not in Hard Run, Hard Program, Fault, Suspend, or Download
mode.

O »  Memory limits for RMC are defined on the memory configuration page. If the limits are exceeded,
your RMC changes cannot complete.
Renaming a Program Organization Unit (POU) in RMC mode creates a POU in the allocated memory
of RMC.

Run mode change actions

The following table explains the supported and unsupported changes during run mode change
(RMC).
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Table 27. Run mode change actions

Category

Supported Action

Unsupported Action

Configuration

Manage data logs and recipes.

Export data logs, recipes, DNP3 mappings,
Modbus mappings, and PCCC mappings.

Change, add, or delete contraoller or /0
configurations.

Variables and
data types

Create global variables and change their
attributes.

Change the following attributes of global
variables that are added before entering RMC:
- Comments

- AMlias

- Retained

Change or remove local variables that are not
referenced by Micro800 controller configuration.
Delete or change the following attributes of
local variables that are referenced by Micro800
controller configuration:

- Comments

- Alias

- Retained

Create, change or remove defined words.

Export global and local variables.

» Delete or change the attributes
of local variables that are
referenced by Micro800 controller
configuration, excluding
Comments, Alias, and Retained.

» Delete existing global variables.

» Change variable attributes or add or
delete variables in a user-defined
function block (UDFB) that is
referenced by a global variable.

« Create, remove, or change
the attributes of user-defined
arrays and structures, excluding
Comments.

» Change or remove the project value
of variables.

«  Change the data type of
dimensional variables.

Projects and
POUs

Change logic in Program Organization Units
(POUs).

Copy/paste POUs within or between sessions.
Rename or delete POUs whose variables are not
referenced by Micro800 controller configuration.
Reset initial values of UDFB instances.
Synchronize updates to references from UDFBs
or UDFs.

Save or export projects.

Change the order of POUs in Project Organizer.
In the Parameter window, change parameters of
UDFs or UDFBs that are not referenced by global
variables.

Export programs.

* Rename or delete POUs whose
variables are referenced by
Micro800 controller configuration.

¢ Add or delete interrupt POUs and
change the properties of interrupts.

»  Remove or rename devices.

* Import projects, POUs, or variables
with the XLSX format.

«  Perform download or upload.

«  Change controller.

Tip:

» Changing a defined word in RMC mode does not download the changes to the controller. To download the
defined word changes to the controller, include additional changes along with the defined word change.

» RMC changes that add comments to arrays or structures not referenced by the Micro800 controller
configuration cannot be downloaded to the controller.

After changing the project value of global or local variables in RMC mode, when reconnecting to the controller,
you cannot enter RMC mode again.
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Run mode change toolbar

Make run mode changes

Rockwell Automation, Inc.

The run mode change (RMC) toolbar includes buttons to start online editing, test, accept, cancel,
and finalize changes. This global-scope toolbar is at the right side of the FactoryTalk Design
Workbench toolbar.

Table 28. RMC toolbar

Item Name Description

e Start online editing Enter RMC mode.

m Test edits Build the Program Organization Unit
to identify errors and warnings.

4/ Accept edits Accept the changes. To retain and
review them the next time you
connect to the controller, accept the
changes before disconnecting.

/X Cancel edits Cancel the changes you've made.

= Finalize edits Download the changes to the

controller without testing or
accepting them.

Run mode change (RMC) allows specific project changes without interrupting the controller
mode. RMC is available for projects using Micro820 L20E, Micro850 L50E, and Micro870 L70E
controllers.

Prerequisites

The contraoller is in one of the following modes after downloading, uploading, or discovering a
project:

* Remote program

* Remote run. The controller must be free of faults and is not in Hard Run, Hard Program,
Fault, Suspend, or Download mode.

To make RMC changes

1. From the RMC toolbar, select # to enter RMC mode.
2. Make the changes as needed.
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3. Download the project to the controller by doing one of the following:
- Select [+ to download the project to the controller without testing. The finalize

action cannot be undone.

When you select [ to finalize edits:

- First, any untested or unaccepted edits are accepted. If a verification error
occurs in any of these edits, the finalize process will stop.
- Next, if there is no verification error, all RMC changes will be downloaded to
the controller.
- Finally, if the controller is in Run mode, the edits will begin to execute.
- select [N to build the Program Organization Unit, resolve errors or warnings as

needed, and then select # to download the project to the controller.

Q If your changes are not tested, accepted, or finalized before disconnecting from the controller,
when reconnecting to the controller, you can enter the previous stage to continue making the
RMC changes.

Project import and export

Export a FactoryTalk Design Workbench project that contains one or more devices. Once
exported, the project can be imported to FactoryTalk Design Workbench when the controller is
offline.

By default, the project is exported to the Downloads folder with the name <project-name>.ftdwa.

An exported project maintains the general structure of the project and might include the
following project configuration options and program elements:
+ Configuration options
- Controller configuration
- Class1 device configuration
- 1/0 module configurations
- Interrupts
»  Program elements
- Programs
- Function blocks
- Global variables
- Local variables

Import a project
Use the Welcome page or the File menu to import a project to FactoryTalk Design Workbench.

» You cannot import a project created in a later version of FactoryTalk Design Workbench
to an earlier version.

 You can import a project with the following controller types from Connected Components
Workbench version 22.00 or 23.00 to FactoryTalk Design Workbench:

68 FTDW-GROOTB-EN-P - April 2026 Rockwell Automation, Inc.



Chapter2  Projects

Table 29. Controllers supporting legacy project import

Controller Type Supported Revision
Micro810 LC10 R7.00

Micro820 L20E R23.00

Micro850 L50E R22.00 or later
Micro870 L70E R22.00 or later

 You cannot import a project created in FactoryTalk Design Workbench to Connected
Components Workbench.

» The import file format is CCWARC for Connected Components Workbench projects or
FTDWA for FactoryTalk Design Workbench projects.

Prerequisites
 Close any open project.

» The controller is offline.

To import a project

1. Open Import project by doing one of the following:
- From the Welcome page, select Import project.
- From the File menu, select Import project.
2. In Import project, select Browse.
In Open, locate and select the file, and then select Open.

4, In Import project, select Import.
Duplicated project names are appended with a number to avoid overwriting the

existing project files.

o~

Export projects
Use Project manager or the File menu to export projects to your computer.
By default, the project is exported to the Downloads folder with the name <project-name>.ftdwa.

Export a project using the File menu

Use the File menu to export the currently opened project to your computer.

Prerequisites

 The project contains one or more devices.

» The controller is offline.

To export a project using the File menu
1. Open the project.

2. From the File menu, select Export project.
3. In Export project, select the export path and enter the file name as needed.
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By default, the project is exported to the Downloads folder with the name <project-

name>.ftdwa.
4, Select Save.

Export multiple projects using Project manager

Use Project manager to export multiple projects to your computer.

To export multiple projects using Project manager

Select Export.

From the File menu, select Project manager.
In Project manager, select one or more projects.

In Export project, select the export path and enter the file name as needed.

By default, the projects are exported as a ZIP file named
<FTDW_projects_yyyy-mm_dd_hh_mm_ss>. The file contains the M8A files for all

exported projects.
5. Select Save.

Import and export project elements

Import and export project elements to transfer the elements from one project to another.
Depending on the element type, the file formats for import and export are different.

Table 30. File format for import and export

Project Element File Format
Micro800 controller programs M8A
Micro800 controller user-defined function blocks M8A
Micro800 controller user-defined functions M8A
Micro800 controller global or local variables CSV or XLSX
Micro800 controller user-defined data types M8A
Micro800 controller data logs M8A
Micro800 controller recipes M8A
Micro800 controller configuration - Modbus mapping CSv
Micro800 controller configuration - MicroLogix™ CSv
mapping

Micro800 controller configuration - DNP3 mapping CSv
Micro800 controller configuration - DNP3 data set M8A
descriptor

Micro800 controller configuration - DNP3 data set M8A

prototype
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Export file descriptions

During exporting, the selected element and all its sub-elements are copied from the project and
exported to files of specific formats.

The following table lists the types of export, what is included in the exported file, and the file
naming conventions.

Table 31. Export file description table

Export Type

File Naming Convention

Exported File Contents

Projects on page
69

<project-name>.ftdwa

All project elements, including device
configurations and programs

Programs on page
72

<project-name_controller-name_program-n
ame>.m8a

All program elements, including local variables
and excluding global variables

Local variables on
page 72

<project-name_controller-name_program-n
ame>.csv/xlsx

All'local variables of the selected program or
function block

Global variables on

page 75

<project-name_controller-name_global>.c
sv/xlsx

All global variables of the project, excluding
automatically generated variables

User-defined data
types on page 77

<project-name_controller-name_data_type
>.m8a

Ail user-defined data types in the project,
including arrays and defined words, excluding
automatically generated data types

Export programs, function blocks, variables, and user-defined data types

Depending on the element type, the file formats for import and export are different.

» The following elements are exported to M8A files:
- Programs, including local variables and interrupts

- Function blocks, including local variables

- Functions, including local variables

- User-defined data types, including array data types, defined words, and structure
data types

- Datalogs

- Recipes

 The following elements are exported to CSV or XLSX files:

- Modbus mappings

- MicroLogix mappings

- DNP3 mappings

- Global and local variables
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Export a program or function block

Use Project Organizer to export the following Program Organization Units (POU) with their
variables to an M8A file:

o Structured text POUs

 Ladder diagram POUs

Function block diagram POUs
»  User-defined function blocks (UDFB) in POUs
«  User-defined functions (UDF) in POUs

By default, the POU is exported to the Downloads folder with the file name:
*  <project-name_controller-name_program-name>.m8a for programs
*  <project-name_controller-name_UDFB-name_UDFB>.m8a for UDFBs

*  <project-name_controller-name_UDF-name_UDF>.m8a for UDFs

To export a program or function block

In Project Organizer, locate the POU you want to import.

Right-click the POU, and then select Export > Program.

In Export program, select the export path and enter the file name as needed.
Select Save.

Export global variables

Use Project Organizer or the Device menu to export the global variables of a controller project
to a CSV or XLSX file. By default, the file is exported to the Downloads folder with the name
<project-name_controller-name_global>.csv/xIsx.

The following automatically generated variables are not exported:
* |/0 variables, such as _I0_EM_D0_00

 Motion variables, such as a motion axis variable with the AXIS_REF data type

 Interrupt variables, such as UFR

To export global variables

1. Open Export global variables by doing one of the following:
- From the Device menu, select Export > Global variables.
- In Project Organizer, right-click Global variables, and then select Export global
variables.
- InProject Organizer, right-click the controller node, and then select Export >
Global variables.
2. InExport global variables, enter the file name, select the file format, and select the
export path as needed.
3. Select Save.
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Export local variables

Use Project Organizer to export the local variables of the following Program Organization Units
(POU) to a CSV or XLSX file:

+  Structured text program

 Ladder diagram program

Function block diagram program
* User-defined function block
* User-defined function

The following automatically generated variables are not exported:
 |/0variables, such as _I0_EM_D0_00
 Motion variables, such as a motion axis variable with the AXIS_REF data type
* Interrupt variables, such as UFR

By default, the file is exported to the Downloads folder with the name <project-name_controller-
name_P0U-name>.csv/xlsx.

To export local variables

1. In Project Organizer, locate the POU that contains the local variables you want to
export.
2. Right-click the POU, and then select Export > Local variables.
3. (optional) In Export local variables:
- Enter the file name.
- Select the file format.
- Select the export path.

File name: | FED_BAT_Project_1_m&50_Program1

Save as type: | Excel Files
Excel Files

Comma separated values files

A Hide Folders

4, Select Save.

Export user-defined data types

Rockwell Automation, Inc.

Use Project Organizer or the Device menu to export all user-defined data types to an M8A
file. Exporting a single data type is not supported. Automatically generated data types are not
exported.

By default, the file is exported to the Downloads folder with the name <project-name_controller-
name_data_type>.m8a.

To export user-defined data types

1. Open Export data types by doing one of the following:
- In Project Organizer, under the Assets node, right-click Data Types, and then
select Export data types.
- From the Device menu, select Export > Data types.

FTDW-GROOTB-EN-P - April 2026 73



Chapter2  Projects

2. InExport data types, enter the file name and select the export path as needed.
3. Select Save.

Import controllers, programs, function blocks, variables, or user-defined data types

Depending on the element type, the file formats for importing and exporting are different.

» The following elements are imported from an M8A file:
- Programs on page 74, including local variables and interrupts

Function blocks, including local variables
- Functions, including local variables

- User-defined data types, including array data types, structure data types, and
defined words

- Datalogs
- Recipes

« The following elements are imported from a CSV or XLSX file:
- Modbus mappings
- MicroLogix mappings
- DNP3 mapping
- Global and local variables

Via CSV or XLSX files, you can manipulate the data and edit a large variable data set.

Import recommendations and considerations

Before importing, review the following recommendations and considerations:

After importing or before downloading the project code to the Micro800 controller, verify
the project code to ensure that the original functionality has been preserved.

+ After importing and replacing programs, in Project Organizer, under the Programs
node, restore the program execution order by moving the program before or after other
programs if needed.

»  When importing a program to a different type of controller than the one it was exported
from, some configured interrupts on page 83 might not be imported.

Only elements that have been previously exported to an M8A, CSV, or XLSX file can be
imported.

» Always verify imported variables for accuracy before using them in a project.

Import a program or function block

Use Project Organizer to import one of the following Program Organization Units (POUs) with its
local variables from an M8A file:

o Structured text POUs

 Ladder diagram POUs
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Import global variables
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*  Function block diagram POUs
» User-defined function blocks in POUs

» User-defined functions in POUs

When importing a function block diagram program from Connected Components Workbench to
FactoryTalk Design Workbench:

+  Program elements might overlap.

+  Variable values might be partially hidden.

Adjust the location and size of the elements in the language editor as needed.

Prerequisites

» Export a program or function block on page 72.

To import a program or function block

1. In Project Organizer, right-click one of the following, and then select Import <POU-
name>.
- Programs
- User-Defined Function Blocks
- User-Defined Functions

2. InImport <POU-name>, select Browse.

In Open, locate and select the M8A file, and then select Open.

4. (optional) In Import <POU-name>, hover over @ 10 view the errors, resolve them, and
then repeat steps from 1through 4 until all errors are resolved.

5. Select Import.

o~

Use Project Organizer or the Device menu to import the global variables of a controller
from a CSV or XLSX file. An existing variable with the same name as the imported one will be

overwritten.

Variables with a user-defined data type are not supported for import unless the project contains
the identical user-defined data type. To avoid problems when importing variables with a user-
defined data type, consider the following steps:
» Before importing the CSV or XLSX file, create the user-defined data type in FactoryTalk
Design Workbench.

Afterimporting the CSV or XLSX file, manually create the user-defined data type, and then
change the data type of the corresponding variables to the user-defined data type you
created.

If a variable property is not valid or the CSV or XLSX file does not meet the formatting
requirements, FactoryTalk Design Workbench might override variables with one or more default
properties. FactoryTalk Design Workbench might not import the variables correctly if the CSV or
XLSX file does not meet the following requirements:

The first two rows of the CSV or XLSX file must contain the following header values:

- Name
- Data Type
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The following header values are optional:

- Dimension
- String Size
- Communication
- Initial Value
- Direction (for user-defined functions and user-defined function blocks only)
- Attribute
- Comment
- MNias
- Retained (Micro810 LC10, Micro870 L70E, and Micro820 L20E controllers only)
- Value
+ Ifacellinthe CSV or XLSX file contains an incorrect variable property or is empty, the
incorrect property or empty cell will be replaced with the default value from the following
table.

Table 32. Default values of variable properties

Variable Property Default Value

Name NewVariableX, where X is unique and increments by one.
Nias <Blank>

Data Type BOOL or Undefined

String Size <Blank>

Communication Read/Write

Initial Value <Blank>

Direction (for UDF and UDFBs only) | Var

Attribute Read/Write

Retained False

Comment <Blank>

Value <Blank>
Prerequisites

» Export global variables on page 72.

To import global variables

1. Open Import global variables by doing one of the following:
- From the menu bar, select Device > Import > Global variables.
- In Project Organizer, right-click Global Variables, and then select Import global
variables.
- InProject Organizer, right-click the controller node, and then select Import >
Global variables.
2. InImport global variables, select Browse.
In Open, locate and select the file, and then select Open.
4. InImport global variables, select Import.

N
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Import user-defined data types

Use Project Organizer or the Device menu to import user-defined data types from an M8A file.
An existing user-defined data type with the same name as the imported one will be overwritten.

To import user-defined data types

1. Open Import data types by doing one of the following:
- InProject Organizer, under Assets, right-click Data Types, and then select
Import data types.
- From the menu bar, select Device > Import > Data types.
2. InImport data types, select Browse.
3. InOpen, select the M8A file, and then select Open.
4. In Import data types, select Import.

Import local variables

Use Project Organizer to import the local variables of one of the following from a CSV or XLSX
file:

Structured text program

+ Ladder diagram program
 Function block diagram program

«  User-defined function block (UDFB)
»  User-defined function (UDF)

An existing variable with the same name as the imported one will be overwritten.

Variables with a user-defined data type are not supported for import unless the project contains
the identical user-defined data type. To avoid problems when importing variables with a user-
defined data type, consider the following steps:
 Before importing the CSV or XLSX file, create the user-defined data type in FactoryTalk
Design Workbench.

 After importing the CSV or XLSX file, manually create the user-defined data type, and then
change the data type of the corresponding variables to the user-defined data type you
created.

If a variable property is not valid or the CSV or XLSX file does not meet the formatting
requirements, FactoryTalk Design Workbench might override variables with one or more default
properties. FactoryTalk Design Workbench might not import the variables correctly if the CSV or
XLSX file does not meet the following requirements:

The first two rows of the CSV or XLSX file must contain the following header values:

- Name
- DataType
» The following row header values are optional:

- Dimension

- String Size

- Initial Value

- Direction (For UDFs and UDBFs only)
- Attribute
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- Comment
- Nias
- Retained (Micro810 LC10, Micro870 L70E, and Micro820 L20E controllers only)
- Value

» Ifacellinthe CSV or XLSX file contains an incorrect variable property or is empty, the
incorrect property or empty cell will be replaced with the default value from the following
table.

Table 33. Default values of variable properties

Variable Property Default Value

Name NewVariableX, where X is unique and increments by one.

Data Type BOOL or Undefined

Dimension <Blank>

String Size <Blank>

Initial Value <Blank>

Direction (For UDFs and Var

UDBFs only)

Attribute Read/Write

Retained False

Comment <Blank>

Nias <Blank>

Value <Blank>
Prerequisites

» Add a program to a project on page 80.
» Export local variables on page 73.

To import local variables

In Project Organizer, locate the POU to which you want to import variables.
Right-click the POU, and then select Import local variables.

In Import variables, select Browse.

In Open, locate and select the file, and then select Open.

In Import variables, select Import.

Work in multiple sessions of FactoryTalk Design Workbench
Create or open separate projects at the same time using different sessions of FactoryTalk

Design Workbench. With multiple sessions opened, you can:

 Open an existing project, and then without closing the existing session, start another
session and use it to create a project.
Open two separate projects, each in a different session.

 Create two projects, each in a different session.
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« Copy a Program Organization Unit (POU) from one session and paste it to another on page
79.
» Goonline in different sessions at the same time with their respective controllers.

IMPORTANT:
»  The same project cannot be opened in different sessions at the same time.

»  Simultaneous builds or POU verifications in multiple FactoryTalk Design Workbench sessions are not
supported. Finish the build or verification in one session before starting in another session.

Copy a Program Organization Unit from one session and paste it to another

Open multiple sessions of FactoryTalk Design Workbench, and then copy Program Organization
Units (POU) from one open session to another open session. The copied POUs reserve their
configuration options.

To copy a POU from one session and paste it to another

1. Open a session of FactoryTalk Design Workbench, and then create a project or open an
existing project.

2. Open another session and another project.

In one session, right-click the POU, and then select Copy.

4. Inanother session, in Preject Organizer, double-click the node under which you want
to paste the POU, and then select Paste.

[
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Programs

A program contains the functions, function blocks, and the associated definitions in devices. A
project can contain up to 256 programs.

Create programs using the following programming languages:

«  Function block diagram (FBD) on page 111

« Ladder diagram (LD) on page 102

o Structured text (ST) on page 117

In Project Organizer, use the Programs node to:
 Create controller programs.
 Import a program from your computer to FactoryTalk Design Workbench.
 Paste a copied program under the node to duplicate the program.
 Add interrupts to the controller project.

» Change the program execution order by moving the program before or after other
programs.

 Open a program.

» Rename programs. Renaming a user program automatically updates all references to the
program.

Use Project Organizer to add a structured text (ST), ladder diagram (LD), or function block
diagram (FBD) program to a controller project.

Prerequisites

» The controller is offline.

To add a program to a project

1. In Project Organizer, right-click Programs, and then select New program.
2. In New program, enter the program name, select the program type, and then enter the
description as needed.

Q The program name must be 1to 128 characters long, starting with a letter or underscore,
followed by letters, numbers, or underscores. The program name cannot contain consecutive
underscores.

3. Select Create.

To rename a program, in Project Organizer, select the program, and then in the Name box of
the Properties pane, enter the new name. Renaming a user program automatically updates all
references to the program.
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Add a user-defined function block using Project Organizer

Use Project Organizer to add a user-defined function block to the controller project.

To add a user-defined function block using Project Organizer

1. In Project Organizer, right-click User-Defined Function Blocks, and then select New
user-defined function block.

2. In New user-defined function block, enter the UDFB name, select the UDFB type, and
then enter the description as needed.

3. Select Create.

Add a user-defined function using Project Organizer

Use Project Organizer to add a user-defined function (UDF) to the controller project.

To add a UDF using Project Organizer

1. In Project Organizer, expand Assets.

2. Right-click User-Defined Functions, and then select New user-defined function.

3. In New user-defined function, enter the UDF name, select the UDF type, and then
enter the description as needed.

4. Select Create.

Add Program Organization Unit descriptions

Use the Description box in the Properties pane to document individual Program Organization
Units (POUs). For example, you can document the implementation details of a POU.

Descriptions are automatically saved and stored in rich text format (*.rtf).

To add POU descriptions

1. In Project Organizer, select the POU.
2. Inthe Properties pane, in the Description box, enter the description.

Duplicate a Program Organization Unit

In Project Organizer, copy and paste a Program Organization Unit (POU) to duplicate it in the
same or between different FactoryTalk Design Workbench sessions, especially when you have
similar PQUs. The pasted POU will have a number appended to it if a POU with the same name
exists.

O » The pasting action pastes the latest version of the copied POU. Once a copied POU is pasted, any
further edits won't update the pasted POU.
It is not supported to copy a program to a user-defined function block (UDFB).

It is not supported to paste a copied POU after it has been deleted.

Prerequisites

» The controller is offline.
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To duplicate a POU

1. In Project Organizer, right-click the POU, and then select Copy.
2. Right-click the node under which you want to paste the POU, and then select Paste.

Delete a Program Organization Unit

Deleting a Program Organization Unit (POU) removes the POU from Project Organizer. Its local
variables are also deleted.

Prerequisites
« The POU is offline.

To delete a POU

Do one of the following:
- In Project Organizer, right-click the POU, and then select Delete.
- InProject Organizer, select the POU, and then from the Edit menu, select Delete.

Verify a Program Organization Unit

Use the Verify program context menu to verify the logic of a single Program Organization Unit
(POU) without building the whole solution. The verification result shows on the Output pane.
On Project Organizer, a symbol will display next to the POU name to indicate any errors or
warnings.

To verify a POU

* InProject Organizer, right-click the POU, and then select Verify program.

Synchronize user-defined function block or user-defined function updates to its
references

After updating the input or output parameters of a user-defined function block (UDFB) or a user-
defined function (UDF), use the Sync updates to references context menu to synchronize all
the updates to its references.

To synchronize UDFB or UDF updates to its references

1. In Project Organizer, right-click the updated UDFB or UDF, and then select Synec
updates to references.

2. Use the following steps to open the instances of the updated UDFB or UDF to verify that
the variables are assigned correctly.
a. Open the program that calls the UDFB or UDF.
b. Inthe language editor, right-click the UDFB or UDF, and then select Open

instruction logic.

c. Verify that variables are assigned correctly.

3. Build the controller project and resolve any build errors.
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Micro800 controllers support interrupts that are used in controller programs.
Use the Programs node in Project Organizer to do the following actions:

»  Open New interrupt to create interrupts of different kinds for Micro800 controller
programs.

» View alist of interrupts created for the Micro800 controller programs.
« Select an interrupt and edit its properties using the Properties pane.
+ Import variables to an interrupt.

* Export an interrupt to your computer.

» Open and edit an interrupt using the language editor.

 Add variables to an interrupt using the local variable grid.
* Delete interrupts.

Table 34. Interrupt types and parameters

Interrupt Type Interrupt Parameters

Event input interrupt (Ell) * Auto start

* Embedded input

Selected timed interrupt (STI) *  Auto start

* Embedded input

User fault routine User fault routine interrupts start when the controller goes to Run made, if
the Program Organization Unit (POU) is configured to start automatically.
There is no available parameter.

Universal plug-in module (UPM) Auto start

High speed counter (HSC) * Auto start

+ Overflow mask

+ Underflow mask
* High preset mask

* Low preset mask

Table 35. Interrupt types supported by different controllers

Controller Type £l STl :’::t'l;:"" UPM HSC
Micro810 LC10 No No Yes No No
Micro820 L20E No Yes Yes Yes No
Micro850 L50E AWB Yes Yes Yes Yes No
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Table 35. Interrupt types supported by different controllers (continued)

Controller Type Ell STl :’::t'“::"" UPM HSC
Micro850 L50E QBB Yes Yes Yes Yes Yes
Micro850 L50E QVB Yes Yes Yes Yes Yes
Micro850 L50E QWB Yes Yes Yes Yes Yes
Micro870 L70E AWB Yes Yes Yes Yes No

Micro870 L70E 0BB(N) Yes Yes Yes Yes Yes
Micro870 L70E QWB(N) Yes Yes Yes Yes Yes

Use the New interrupt dialog to create interrupts for Micro800 controller programs. The
available interrupt types vary with the controller selection. When you are adding, configuring, or
deleting interrupts, the controller must be offline.

Use interrupts to:

Set time intervals between executions of ladder subroutines.
Force user interrupt functions to start without using ladder logic.
Allow or prohibit overflows and underflows for high-speed counter (HSC) interrupts.

Allow or prohibit high and low presets for HSC interrupts.

Prerequisites

Create a Micro800 controller project.

The controller is offline.

To add an interrupt
1. In Project Organizer, right-click Programs, and then select New interrupt.
2. In New interrupt, do the following:
a. Inthe Name box, enter the interrupt name.
b.  From the Type list, select an interrupt type.
c. Fromthe ID list, select an identifier for the interrupt.
d. From the Program type list, select the program type in the project for the
interrupt usage.
3. Select the parameters for the interrupt type.
4. Select Create.

Q - Todelete an interrupt, in Project Organizer, right-click the interrupt, and then select
Delete.
- Toedit an added interrupt, in Project Organizer, select the interrupt, and then edit the
properties in the Properties pane.
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Interrupt instructions

To avoid potentially corrupting global variables and unnecessary warnings during an interrupt,

use the interrupt instructions.

Table 36. Interrupt instructions

Function Block

Description

uic

Clears Interrupt Lost bit for the selected user interrupts.

ub

Turns off the specific user interrupts.

UIE

Turns on a user input.

UIF

Removes a pending user input for the selected user interrupts.

Rockwell Automation, Inc.
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1/0 configurations

Use the 170 configurations node in Project Organizer to add and configure the following 1/0
components:

» Embedded I/0s on page 86

*  Plug-in modules on page 89

» Expansion modules on page 91

 Ethernet devices on page 95

Embedded 1/0 configuration page
Use the <controller-catalog-number> Embedded 1/0 page to:
 View the variables associated with the I/0 points by selecting the Variable node.

 View and configure the embedded 1/0 parameters of a Micro800 controller by selecting
the Configuration node.

The number of 1/0 parameters varies with the Micro800 controller type. For Micro850 L50E and
Micro870 L70E controllers, you can configure the inputs as latch inputs on page 88 that detect
the rising and falling edge of external inputs.

To open the embedded 1/0 configuration page, do one of the following:

* In Project Organizer, expand 1/0 Configurations, and then double-click Embedded.

* In Project Organizer, expand 1/0 Configurations, right-click Embedded, and then select
Properties.
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Rockwell Automation, Inc.

Figure 12. Micro800 controller embedded 1/0 Configuration - Variable page

2080-L70E-24QWBN Embedded I/0
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Figure 13. Micro800 controller embedded 1/0 Configuration - Configuration page

2080-L70E-24QWBN Embedded 1/0
Parent: MyController

Information

Configuration

Variable
Configuration Input Input Filter

01 DC 5 us -

23 Default -

43 Default -

67 Default -

89 Default -

10-11 Default -

1213 Default -

Input Input Latch Ell Edge

0 Disabled v | Falling -
1 Disabled v | Falling -
2 Disabled v | Falling -
3 Disabled + | Falling -
4 Disabled ¥ | Falling -
5 Disabled ¥ | Falling -
6 Disabled * | Falling -
7 Disabled * | Falling -
8 Disabled v | Falling ¥
9 Disabled v | Falling %
10 Disabled + | Falling -
n Disabled + | Falling -
12 Disabled ¥ | Falling -
13 Disabled * | Falling -

Configure a latch input

Alatch input, or a pulse-catching input, captures a fast pulse and holds it for a controller scan.
The input filter determines the captured pulse width. For Micro850 L50E and Micro870 L70E
controllers, you can configure certain inputs as latch inputs, set the input filter value, and then
configure the rising and falling edge behaviors of each latch input.

Latch inputs change states faster than can be detected and cannot normally be detected by the input
scan portion of the Micro800 controller's scan cycle.

To configure a latch input

1. In Project Organizer, expand 1/0 Configurations.
2. Openthe embedded I/0 configuration page by doing one of the following:
- Double-click Embedded.
- Select Embedded, and then select the Enter key.
3. On the <controller-catalog-number Embedded 1/0> page, select Configuration.
4. In the Input Latch column, select one of the following for each latch input:
- Select Rising to detect the pulse on the rising edge of the external input.
- Select Falling to detect the pulse on the falling edge of the external input
b.  Select the Ell edge direction as needed.
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Plug-in modules

Rockwell Automation, Inc.

The 2080 plug-in modules are attached to the Micro800 controller to extend controller capability
without increasing the controller's footprint. Use plug-ins for adding 1/0s, communications,
memory backup, and specialty capabilities.

Micro820 L20E, Micro850 L50E, and Micro870 L70E controllers support plug-in modules. You can
configure whether to fault the controller when the plug-in module is absent.

The following image shows a Micro870 L70E controller configuration with three plug-in modules.
Use the PLUGIN_INFO instruction to verify whether a plug-in module is present.

Figure 14. Micro870 L70E controller configuration with three plug-ins

Project Organizer a1 =

ED B

Q. Search

v [ MyController [2080-L70E-24QBBN]

¢ Global Variables

» . Programs
» L Assets
+ % 1/0 Configurations
B Embedded
~ [ Plug-in [3/3]
B [1] 2080-SDMEMRTC-5C
B [2] 2080-0F2
B [3] 2080-DNET20
» B Expansion [3/9]
» [ Ethernet [1/8]

After attaching a plug-in module to the controller:

* In Project Organizer, the <plug-in-catalog-number> node is created under 1/0
Configurations > Plug-in. To open the <plug-in-catalog-number> page, double-click
the <plug-in-catalog-number> node.

*  On the <plug-in-catalog-number> page, select a node to open the corresponding page
and configure the plug-in settings.

Table 37. Supported 2080 plug-in modules

Catalog Number Type Description

2080-1F2 Analog 2-channel Voltage/Current Input

2080-IF4 Analog 4-channel Voltage/Current Input

2080-0F2 Analog 2-channel Voltage/Current OQutput
2080-RTD2 Analog 2-channel Resistance Thermometer Detector
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Table 37. Supported 2080 plug-in modules (continued)

Catalog Number Type Description

2080-TC2 Analog 2-channel Thermocouple

2080-DNET20 Communication DeviceNet

2080-SERIALISOL Communication RS232/485 isolated serial port

2080-104 Digital 4-point digital input module

2080-1040B4 Digital 8-point digital combination module

2080-1040V4 Digital 8-point digital combination module

2080-0B4 Digital 4-point digital output module

2080-0v4 Digital 4-point digital output module

2080-0w4l Digital 4-point relay output module

2080-MEMBAK-RTC2 Specialty Memory backup and real-time clock (RTC)

2080-SDMEMRTC-SC Specialty MicroSD card and high accuracy RTC
Itis notan Allen-Bradley® plug-in. It is from Rockwell
Automation Encompass™ Product Partner-Spectrum
Controls.

2080-MOT-HSC Specialty Operates in high-speed counter mode or motion axis
feedback mode

2080-TRIMPOT6 Specialty 6-channel trimpot analog input

Add a plug-in module to the controller

Use plug-ins to expand Micro800 controllers for extra 1/0s, communications, memory backup,
and specialty capabilities.

To add a plug-in module to the controller

In Project Organizer, go to I/0 Configurations > Plug-in.

Right-click Plug-in, and then select New module.

In Add module, select a plug-in module, and then select Add.

In Devices definition, configure the slot, revision, and controller fault settings, and
then select OK.

O To open the configuration page of a plug-in module, in Project Organizer, double-click <plug-
in-ID>.
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Expansion modules

Rockwell Automation, Inc.

The 2085 expansion modules are attached to the right side of Micro850 L50E and Micro870 L70E
controllers to extend their capabilities. The number of supported expansion modules varies with
the controller type:

*  Micro850 L50E controllers with less than 24 digital /0 points support up to four
expansion 1/0 modules and up to 132 digital I/0 points.
*  Micro850 L50E controllers with 48 digital I/0 points support up to four expansion 1/0
modules and up to 192 digital I/0 points.
Micro870 L70E controllers support up to eight expansion 1/0 modules if a power supply
module is attached, and support up to 304 digital I/0 points.
In FactoryTalk Design Workbench, you can configure whether to fault the controller if an
expansion module is absent. To check if an expansion module is present, use the MODULE_INFO
instruction.

The following image shows a Micro870 L70E controller configuration with three expansion
modules and a power supply module. The power supply module must be in slot 2, 3, 4, or b.

Because the Micro870 L70E expansion module does not have inputs or outputs, it uses a
physical slot instead of a logical slot.

Figure 15. Micro870 L70E controller with expansion modules

E DB
Q. Search

» [ MyController [2080-L70E-24QBBN]

¢ Global Variables

» % Programs
» % Assets
+ % 1/0 Configurations
8 Embedded
» B Plug-in [3/3]
+ [ Expansion [3/9]
§ [1] 2085-IRT4
B [2] 2085-1Q32T
E [3] 2085-EP24VDC
» [ Ethernet [1/8]

After adding an analog or digital expansion module to the controller:
*  Global variables are created in the controller project to support the additional I/0 points.

» The module's catalog and slot number are shown in Preject Organizer. To open the
expansion module's configuration page, in Project Organizer, go to 1/0 Configurations >
Expansion, and then double-click the expansion module.
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Table 38. 2085 expansion modules

Model Number Type Description

2085-1F4 Multi-channel analog 4-channel 14-bit analog and current input module

2085-1F8 Multi-channel analog 8-channel 14-bit analog and current input module

2085-IRT4 Multi-channel analog 4-channel RTD and TC temperature module

2085-0F4 Multi-channel analog 4-channel 12-bit analog voltage and current output
module

2085-1A8 Discrete 1/0 digital 8-channel 120V AC input module

2085-IM8 Discrete 1/0 digital 8-channel 240V AC input module

2085-1016 Discrete 1/0 digital 16-channel 24V DC sink/source input module

2085-1032T Discrete 1/0 digital 32-channel 24V DC sink/source input module

2085-0A8 Discrete I/0 digital 8-channel 120/240V AC output module

2085-0B16 Discrete I/0 digital 16-channel DC source output module

2085-0V16 Discrete I/0 digital 16-channel DC sink output module

2085-0W16 Discrete I/0 digital 16-channel relay output module

2085-0W8 Discrete I/0 digital 8-channel relay output module

2085-EP24VDC Power supply 24V DC power supply module

For more information about expansion modules, see Micro830, Micro850 and Micro870 Programmable Controller
User Manual - 2080-UM002_-EN-E.

Add an expansion module to a controller project

Expansion 1/0 modules extend the capabilities of Micro850 L50E and Micro870 L70E controllers
by optimizing the flexibility of the 1/0 count and type.

For Micro850 L50E controllers:
+ Add no more than four expansion modules.

 Toavoid program compiling problems, limit the total number of digital inputs and outputs
to:

- 192 or less for Micro850 L50E controllers with 48 digital 1/0 points.
- 132 or less for other Micro850 L50E controllers.
For Micro870 L70E controllers:

 Add no more than eight expansion modules and no more than one power supply
expansion module.

+ Toavoid program compiling problems, limit the total number of digital inputs and outputs
to 304 or less.
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To add an expansion module to a controller project

In Project Organizer, go to 1/0 Configurations > Expansion.

Right-click Expansion, and then select New module.

In Add module, select an expansion module, and then select Add.

In Devices definition, select the slot, revision, and controller fault behavior as needed,
and then select OK.

Configure the scan interval for expansion modules

Rockwell Automation, Inc.

Micro870 L70E controllers support configuring the scan interval for individual expansion
modules, except the power supply module. This allows the controller to selectively skip scanning
specific expansion modules during Run mode. For example, setting the scan interval for

analog modules to every five cycles reduces the over-scanning of slowly-changing analog data,
reducing the program cycle time.

O Optimizing the scan interval to reduce the program cycle time is effective only when there are more than
four expansion modules.

Prerequisites

 Add a Micro870 L70E controller to the project.
 Add an expansion module to the controller on page 92.

To configure the scan interval for expansion modules

1. In Project Organizer, go to 1/0 Configurations > Expansion.

2. Right-click Expansion, and then select Scan cycle.

3. InScan cycle, from the Custom scan interval list, select the scan interval.
By default, analog modules use the selected Custom scan interval, and digital
modules are set to Every Scan.

4. Select Syne initial to start scanning all modules simultaneously as needed.
During the first scan after changing from Program to Run mode, all modules will be
scanned, regardless of their Sync initial configuration.

5. From the Scan interval list, select Every scan or Custom scan interval for individual
modules as needed.

6. Select OK.
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Figure 16. Scan interval for expansion modules
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Replace an expansion module

Use these steps to replace an expansion module with another one in a controller project.

Prerequisites

To replace a module using the Replace module menu, at least one module must be
added to the controller.

To replace a module using the New module menu, at least two modules must be added to
the controller, and the module you want to replace is not in the last slot.

To replace an expansion module

94

Do one of the following:
- Toreplace an expansion module using the Replace module menu
1. In Project Organizer, go to 1/0 Configurations > Expansions.
2. Expand Expansions, right-click the module you want to replace, and then
select Replace module.
3. In Add module, select the new module, and then select Add.
4. InDevices definition, configure the settings as needed, and then select OK.
- Toreplace an expansion module using the New module menu
1. In Project Organizer, go to 1/0 Configurations > Expansions.
2. Expand Expansions, right-click the module you want to replace, and then
select Delete.
In Warning, select NO.
Under Expansions, right-click Available, and then select New module.
In Add module, select the new module, and then select Add.
In Devices definition, configure the settings as needed, and then select OK.
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Ethernet device settings

Rockwell Automation, Inc.

After adding an Ethernet device on page 97, a <device-name> node is created under

Ethernet in Project Organizer. To view and configure the Ethernet devices, do one of the

following:

» Double-click the node.

* Right-click the node, and then select Properties.
The settings displayed on the <device-catalog-number: device-name> page vary with type of

the device that you added.

Table 39. Ethernet device settings

Setting

Description

Information - Overview

Displays:

»  The device catalog ID.

+  The device vendor.

» The electronic keying and Ethernet address settings you entered when
adding the device.

» The IP address of the device.

»  The drive rating of the device.

»  The Device definition button.
Select the button to open the Device definition dialog and change the
settings as needed.

Settings in the Devices definition dialog

Device type Displays the catalog number of the added device. It is read-only.

Name Displays the device name that you entered. The name must be unique. Do
not set a name using the device type because it contains reserved words.
We recommend that you attach a number to the device type. For example,
powerflex523_1.

Description Displays the additional information about the device. It is optional.

Ethernet address Specifies the IP address of the added device. The default address is 1.1.1.1.

Revision Displays the device revision, comprising a major revision number followed

by a minor revision number.
»  Major revision indicates the revision of the interface to the device. It is
from 0 through 127. The default value is 0.

« Minor revision indicates the firmware revision. It is from 0 through 255.
The default value is 0.

Electronic keying

Displays the selected electronic keying option. Electronic keying reduces
the possibility of using an incorrect device in the control system by
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Table 39. Ethernet device settings (continued)

Setting Description

comparing the device specified in the project with the installed device. The

available options vary with the selected device type:

«  Compatible module allows the installed device to accept the key of
the device that is defined in the project when the installed device
can emulate the defined device. It is typically used in the following
scenarios when replacing one device (device A) with another (device B):
- Device A and device B have the same catalog ID.

- Device B has the same or a later major revision than device A.

- When device A and device B have the same major revision, device
B must have the same or a later minor revision than device A;
when device B has a later major revision than device A, device B's
minor revision can be any number.

 Disable keying disregards the keying attributes when attempting to
communicate with a device and might result in communicating with a
device whose type is different from the type specified in the project.

« Exact match indicates that all keying attributes must align to
establish communication. If any attribute does not match precisely,
communication with the device will not be established.

Mode Specifies the device operating mode. Options include:

« Velocity

* Position

The setting is available for the PowerFlex® 525-EENET and PowerFlex

525-E2P device type.

Drive rating Lists the power rating with global voltage classes of the drive. It is available

when you select a PowerFlex drive.

Configuration - Connection

Requested packet interval

Specifies the connection update rate. The connection transfers data to or
from the device at least as frequently as specified.

The value is from 5 through 9999.9. The default value is 20.0. The range for
Kinetix® 5100 is from 5 through 3200.

The setting is configurable when the controller is online.

Unicast connection over EtherNet/IP

Determines whether to use a unicast connection over EtherNet/IP or
multicast connections.

The setting is configurable when the controller is online.

Inhibit module

Determines whether to inhibit the connection to the module.

The setting is configurable when the controller is online.

Major fault on controller if
connection fail while in run mode

Enables the controller to check the Class 1communication with the device
when switching from Proegram to Run mode. If connected, the controller
enters Run mode. Otherwise, the 0xF8A4 fault occurs.

Connection - Connection fault

Shows the connection fault information if any while online.

Configuration - Comm config
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Add an Ethernet device

Rockwell Automation, Inc.

Table 39. Ethernet device settings (continued)

Setting Description

Communication format

0.

Specifies the device communication format. The setting is available for
generic devices.

The selected communication format for an /0 module determines how
the module communicates with the controller, which configuration pages
are available, and the tag structure and configuration method that you
will use to configure the module. Specifically, the communication format
determines:

« The format of the input and output data for the I/0 module

« The format of the configuration data for the I/0 module

Input Assembly instance specifies the input connection point for
the primary connection. The value is from 1through 65535. The
default value is 1.

Input size specifies the size of the input assembly instance. The
size range varies with the selected Communication format:

Data - DINT: From 1through 125

Data - INT: From 1through 250

Data - REAL: From 1through 125

Data - SINT: From 1through 500
Input data - DINT: From 1through 125
Input data - INT: From 1through 250
Input data - REAL: From 1through 125
Input data - SINT: From 1through 500

Output Assembly instance specifies the output connection point
for the primary connection. The value is from 1through 65535. The
default value is 1.

Output size specifies the size of the output assembly instance.
The size varies with the selected Communication format:

Data - DINT: From 1through 124
Data - INT: From 1 through 248

Data - REAL: From 1through 124
Data - SINT: From 1through 496

« Configuration Assembly instance specifies the target of the
connection. The value is from 1through 65535. The default value is 1.

» Configuration Size specifies the number of 8-bit configuration words
that is required to communicate with the module. The assembly
comprises the default configuration array and the additional portions
from other arrays. The value is from 0 through 400. The default value is

Use Project Organizer to add an Ethernet device to a project.
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To add an Ethernet device

In Project Organizer, expand 1/0 Configurations.

Right-click Ethernet, and then select New device.

In Add device, select a device, and then select Add.

In Devices definition, configure the parameters on page 95, and then select OK.
A <device-name> node is created under Ethernet.
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Language editors

Use the language editor to develop the content of Micro800 programs.
Alanguage editor holds elements from the following programming languages:

* Ladder diagram (LD)

«  Structured text (ST)

«  Function block (FB)
There is an additional language editor for user-defined function blocks (UDFBs).
In language editors:

» Each program in a project opens a separate language editor in the application
workspace, with program names shown on the workspace tab.

 You can open several workspaces at the same time.

» Use Toolbox to inset elements to the language editor.

Work with elements in language editors

Use the language editors to manage individual or multiple elements for Micro800 controller
programs. The selected elements are highlighted in blue.

Table 40. Working with elements in language editors

To Do this
Select an individual element Select the element in the language editor.
Select multiple elements Do one of the following:

Select the first element, and then select the last element while holding
Shift.

*  Select each individual element while holding Ctrl.

The elements must be within the same rung.

Insert an element to a language From Toolbox, drag the element to the language editor.
editor
Delete elements Do one of the following:

* Inthe language editor, select one or more elements, and then select the
Delete key.

» Inthe language editor, right-click an element, and then select Delete.

Deleting a variable does not delete the variable from the dictionary.

Move elements In the language editor, select one or more elements, and then drag the
elements to another location within the language editor.

You can select multiple elements only within the same rung.
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Table 40. Working with elements in language editors (continued)

To Do this

Resize elements Select the element, and then drag the element handle until it reaches the
desired size.

Open the local variables grid In the language editor, select <.

Show or hide qrids in function block In the |anguage editgrl select E or g
diagram programs

Zoom in or zoom out Do one of the following:

o Select ®\ or O\

«  Scroll the mouse wheel upward or downward while holding Ctrl.

Toolbox

Use Toolbox to find and add program elements to a language editor.

Toolbox contains the elements associated with the ladder diagram language on page 103,
function block diagram language on page 112, or structured text language on page 118.

In Toolbox:

» Use Search or select a category from the list to filter program elements.
 Hover over an element to view its name, description, and image.
* Drag the border between the category and list pane to resize the panes.

Table 41. Working in Toolbox

To Do this

Pin or unpin Toolbox Do one of the following:

. Select#‘nr%.

o Select E, and then select Pin or Unpin.

Shrink down Toolbox and leave [ Select =, and then select Collapse.
just a tab

Show the content of Toolbox | Select =, and then select Expand.

Hide Toolbox Select =, and then select Close.

Create a variable in language editors

In language editors, create variables for an instruction. The variable will simultaneously be
created in the local variable, global variable, or the defined word grid, depending on the scope
you selected.
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To create a variable in language editors

1. Open New variable by doing one of the following:
- Inthe ladder language editor, on an instruction, right-click an operand, and then
select New variable.
- Inthe function block diagram language editor, right-click an input reference,
output reference, or variable, and then select New variable.
- Inthe structured text language editor, right-click anywhere, and then select New
variable.
2. In New variable:
- Onthe General page, enter the variable name. The scope and data type of the
variable are automatically filled.
- Onthe General and Advanced pages, specify other parameters as needed.

3. Select Create.

View instruction block logic

Open the instruction block logic to view and edit the logic, input, and output of a user-defined
function (UDF) or user-defined function block (UDFB).

To view instruction block logic

1. Open the program that contains the UDF or UDFB.
2. Right-click the UDF or UDFB, and then select Open instruction logic.

View instruction block parameters
In language editors, use the Open instruction parameters context menu to view the local

variables that are assigned to the instruction block.

To view instruction block parameters

« Inthe language editor, right-click the instruction block, and then select Open instruction
parameters.
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Ladder diagram language

A ladder diagram (LD) is a graphical representation of Boolean equations that combines
contacts (input arguments) with coils (output results).

The LD language uses graphic symbols in a program chart that is organized like a relay ladder
wiring diagram to describe the tests and modifications of Boolean data.

LD graphic symbols are organized within the chart as an electrical contact diagram. The term
"ladder" comes from the concept of rungs connected to vertical power rails at both ends, where
each rung represents an individual circuit.

FactoryTalk Design Workbench includes an LD language editor and supports specific elements
and instructions that are provided exclusively by the FactoryTalk Design Workbench software.

Ladder diagram program development environment

This section introduces the ladder diagram (LD) program language editor, where you develop LD
Program Organizational Units (POU).

Figure 17. Ladder diagram program development environment

(6

LDPfogrgm =  Connection o =
70ECpntrgllef » [Programs » LDProgram L70EController [2080-L70E-24 ®
Path: 10.224.110.207 =
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0 COP_1
Va _é-C Write
A_Data
TRUE I
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0 &=
Q, Search
EQ WriteValue H (=]

= ° Common >II|
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Properties o =

Program
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End
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Ladder editor Toolbox

Rockwell Automation, Inc.

Table 42. LD program development environment

Description

Item
o Opens the local variable grid to view the variables used by the current program.

Goes to the rung with the entered rung number.

Zooms in the editor. It resets when the tab is closed and does not affect other tabs.

Resets the editor to 80% zoom.

Makes up the primary portion of the LD editor. In this area, you edit logic using graphical
instruction elements.

o Zooms out the editor. It resets when the tab is closed and does not affect other tabs.

1 Adds instructions and elements to the editor.

Use the ladder editor Toolbox to add program elements to the ladder diagram.

Toolbox is displayed by default. If it is hidden, do one of the following:
«  From the pane bar, select E=5.

«  From the View menu, select Toolbox.
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Ladder diagram language

Figure 18. Ladder editor Toolbox
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Table 43. Ladder editor Toolbox

Item

Description

Adds a rung to the ladder diagram.

Contains the entered element name for quick finding.
As you enter, elements that contain the search text appear in Toolbox.

Adds a branch to the ladder diagram.

Adds a parallel branch to an existing branch.

(2]

©

4]
1

program elements.

Displays the categories of the program elements. Selecting a category filters the displayed

2

Displays the program elements of the selected category.

Ladder diagram value display

This section explains how variable values are displayed in ladder diagram programs for boxed

104

instructions when the controller is offline.
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For programs
When there is no initial value for a variable:

 The default value is displayed in the instruction box and variable grid. For the STRING
data type, the default value is empty.

mﬂ = Name Value Initial Value
0 = » a 0
i2 ?
ol ?
ANY_TO_STRING
o Name Value Initial Value

string1

il string1
B
o1

 You can change the value of the variable in the instruction box or variable grid.

”
= = Name Value Initial Value
2i*| » a 2
2
o1
ANY_TO_STRING [
Name T Value Initial Value

no [ gl

‘This is a string’ = string1 'This is a string'

ol

When there is an initial value for a variable:

+ The default value or a previously entered value is displayed in the instruction box or
variable grid. For the STRING data type, the default value is empty.

Value Initial Value
a a
Value Initial Value T

‘This iz the initial value of L.

 You cannot change the value in the instruction box or variable grid. The initial value is
displayed in the variable grid.

Value Initial Value
LI 2 3
2 [
A
Value Initlal Value T
'MyString’ 'This iz the initial value of ...
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Ladder diagram language

For user-defined function block (UDFB) Program Organizational Units (POU)
When there is no initial value for a variable:

 The value is empty and read-only.

 The variable grid does not include a Value column.
Name Initial Value
» a
When there is an initial value for a variable:

+ The value in the instruction box is empty and read-only.

* The variable grid does not include the Value column, but a previously entered initial value
displays in the Initial Value column.

MName Initial Value

P oa 3

For user-defined function (UDF) POUs
When there is no initial value for a variable:

» The value in the instruction box is empty and read-only.

 The variable grid does not include a Value column.

Name Initial Value

b oa
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When there is an initial value for a variable:

 The value in the instruction box is empty and read-only.

» The variable grid does not include the Value column, but the Initial Value column
displays a previously entered initial value.

Mame Initial Value

 a 3

For an instance variable of a function block in a program, UDFB, or UDF

 The value of the instance is empty for each operand of the function block.

 After uploading the project, the value of all operands, excluding the instance variable, is

empty.
cTu
CTU ctu Q
Reset cu
PV

cv

Work in the ladder diagram language editor

Elements are added to the ladder diagram language editor according to the following rules:
» The first element on a rung is added at the position that you selected.
» Subsequent elements are added to the right of the selected element on the rung.
 Itis not supported to insert an element to the right of a cail return or jump.

The methods to add elements to the LD program are as follows:

Table 44. Methods to add an element to the LD program

Method Description
Ladder editor Adds, deletes, or copies and pastes elements.
Toolbox Adds elements and instructions to the LD program.

Toggle Bit command

Use the Toggle Bit command to change the state of a Boolean tag.

* If the tag is on, toggle turns it off.
 If the tag is off, toggle turns it on.
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If the controller is offline or in Program mode, the toggled Boolean state will remain until
manually changed.

If the controller is in Run mode, the toggled Boolean state might be overwritten by:

» The rung scan, if the ladder logic has outputs that reference the toggled Boolean tag.
» The input scan, if the Boolean tag references an /0 input module.
 Forcing, if the Boolean tag references an |/0 module.

Figure 19. Toggle Bit command

OneShotFalling

F
I < cut ctrl + X
Copy ctrl+C
— @ Delete Delete
Add element Insert
Toggle bit Ctrl+T

Ladder diagram program examples

The following examples demonstrate ladder diagram programs.

Example: OSR function block

The following example program shows the recommended usage of an OSR function block to
detect an edge while connected to the contraoller.

Figure 20. Example: OSR function block

Using Outputs o with a Positive or Negative Edge Input Contact is NOT recommended. The Positive or Negative Edge Pulse Input Contact is for Physical inputs in
ladder diagram
Any_Variable _I0_EM_D0_01
P L
The 0OSR and OSF function blocks are supported and work in any location in your program. It is recommended if you need to detect a rising or falling edge with any variable
input or output.
Any_Variable OSR -10_EM_DO_00
1 OSR OSR_1 Q L
CLK
This is the TYPICAL way to use Positive or Negative Pulse Contact with physical inputs in ladder diagram programs
_I0_EM_DI_00 Any_Variable
z P u

Using Output or variables with Positive or Negative Edge Pulse Contact is not recommended but works if the Output or variable is located AFTER the rung, which is triggering
the edge.

Any_Variable _I0_EM_DO_02
3 P L

Example: Comparing REAL Values using SUB (-), ABS, and LT (<)

It is not recommended to use the REAL data type for equality comparisons due to rounding
differences. Two values might appear equal in FactoryTalk Design Workbench but evaluate as
false.

For example, 23.500001 and 23.499999 both display as 23.5 but are not equal in the controller.

To compare REAL values, use a SUB instruction to find the difference and check if it is less than
a set precision value. See the LD program example for details.
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Figure 21. Example: Comparing Real Values using SUB (-), ABS, and LT (<)

A - First REAL value for comparison
B - Second REAL value for comparison
Difference - A-B

SuUB
il A
0.0/ 4=
i2 B
0.0 o=
ol Difference
0.0/ 4=
Get the absolute value of Difference
ABS
1 IN Difference
0.0 4=
ABS Difference
0.0 4=
A_equals_B is TRUE if Difference is smaller than the desired
Precision
LT A_equals_B
2 i1 Difference — 01— U
0.0 o=
i2 Precision
0 4=

Enable EN/ENO in ladder diagram instructions

The rung state in a ladder diagram (LD) diagram is always Boolean, and the first input and first
output of an instruction are connected to the rung. For instructions that have EN inputs or ENO
outputs, use the Properties pane to enable or disable EN/ENO:

*  When enabled, the value of the EN input or ENO output parameter is shown on the bit lag.
»  When disabled, the value of the EN input or ENO output parameter is shown in the
instruction box.
When EN/ENO is disabled:

 Assign a variable to or enter the value for the EN input or ENO output parameter for
instructions that have instances.

* Assign a variable to or enter the value for EN input or ENO output parameters for
instruction that do not have instances.

IMPORTANT:

»  Auser-defined input parameter cannot be used to enable or disable user-defined functions (UDF) or user-
defined function blocks (UDFB) because the input parameter only enables or disables the instructions
inside the UDF or UDFB.

Toenable or disable the running of a UDF or UDFB, select the EN/ENO checkbox using the Properties pane
for the specified UDF or UDFB. For example, when EN/ENO is turned off, the UDFB does not execute and
the output parameters are not overwritten.
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To enable EN/ENO in ladder diagram instructions

1. In the ladder diagram language editor, select an instruction block instance.

2. InProperties, turn on EN/ENO.
In some cases, enabling parameters are required for the instructions that execute on
call. The following example shows an SUS instruction block with an Enable input.

SUs SUS_1
Enable _I0_EM_DO_00
SusID _SYSVA_SUSPEND_ID
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Function block diagram language

A function block diagram (FBD) program is a graphical representation of the input and output
relationships in a control system. Build your FBD programs using existing functions from a
standard library, function section, or function block section.

The FBD language supports using the following instruction blocks that are supplied with
FactoryTalk Design Workbench only:

» Operators

*  Function blocks

* Functions

+  User-defined function blocks

Function block diagram program development environment

The following diagram shows the language editor for a function block diagram (FBD) program,
where you develop FBD Program Organizational Units (POU).

Use the FBD Toolbox or FBD keyboard shortcuts on page 21 to add elements to an FBD POU.

Figure 22. FBD program development environment

0

PID_FBDLEG = Connection g =
icrop70 rograms » PID_FBD_EG Micro870 [2080-L708-2.. g

Path
Q B Q4%Q

Mg i

Toolbox 4 =

e e Q, Search

D a © o

e User-defined

= 3 = Bit

Program Control >|I’

My_GainTransfer
My_Limit
My_PWM

My_Scaler

KMy TamnCanuvart

Properties B =
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Table 45. FBD program development environment

Item Description

Opens the local variables grid to view the variables that are used by the current
program.

Displays or hides the gird lines.

It resets when the tab is closed and does not affect other tabs.

Zooms in the editor. It resets when the tab is closed and does not affect other tabs.

Zooms out the editor. It resets when the tab is closed and does not affect other tabs.

Resets the editor to 100% zoom.

Makes up the primary portion of the FBD editor. In this area, you edit logic using
graphical instruction elements.

© 000 00

1 Adds instructions and elements to the editor.

Function block diagram Toolbox

Use the function block diagram (FBD) Teolbox to add program elements to the FBD program.
Toolbox is displayed by default. If it is hidden, do one of the following:

«  From the pane bar, select E=5.

*  From the View menu, select Toolbox.
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Figure 23. FBD Toolbox

User-defined
Bit

Program Control
Al
Math

Compare

Move/Copy

L

RPC
sSUs
SYS_INFO

TND

Table 46. Function block diagram Toolbox

Description

Item
o Creates a reference to an input variable.

Contains the entered element name for quick finding.
As you enter, elements that contain the search text appear in Toolbox.

Create a reference to an output variable.

Contains the entered FBD program description. Descriptions are free-format text used for
documentation purposes only and are not acted upon by the program.

o Creates a reference to an input or output variable.

1 Displays the categories of the program elements. Selecting a cateqgory filters the displayed
program elements.

- Displays the program elements of the selected category.

Function block diagram main format

Rockwell Automation, Inc.

A function block diagram (FBD) on page 111 includes instruction blocks with input and output
variables.

The outputs of instruction blocks are connected to the inputs of other instruction blocks using
connection lines.
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In FactoryTalk Design Workbench, an instruction block refers to the following types of
instructions:

» Operator

« Function

 Function block

« User-defined function block

Figure 24. FBD example

Output

Function block diagram program inputs and outputs

This section introduces the input and output variables, and the connection lines in a function
block diagram (FBD) program.

Input and output variables

In an FBD program, each input variable must be connected to a block input and the data type of
the input is correct. A block input can be a literal value, an internal variable, an input variable, or
an output variable from another block.

Each output variable must be connected to a block output and the data type of the output is
correct. A block output can be an internal variable, an output variable, or the name of a block
(for functions only). If the output is the name of an edited function, the output represents the
assignment of the return value for the function, and the output value is returned to the calling
program.

Connecting inputs and outputs

Variables, inputs, and outputs in an FBD program are connected or wired using connection lines
or links. You can connect any of the following logical points in an FBD diagram using a single
line:

« Connect an input variable to a block input.
» Connect an output variable to a block output.
» Connect a block output to the input of another block.

Connections are oriented from left to right, carrying data from left to right. The left connection
and the right connection must be of the same data type.

A single left connection point can be connected to multiple right connections, called
divergences, to broadcast information to multiple points. All connections must be of the same
data type.

Instruction blocks in function block diagram programs

The FactoryTalk Design Workbench instruction set includes instruction blocks in compliance
with IEC 61131-3. Instruction blocks collectively include function blocks, functions, and operators.
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Connect instruction block inputs and outputs to variables or other instruction block inputs and
outputs.

Instruction block conventions

The IEC6T131-3 programming language specification addresses numerous aspects of
programmable controllers, including operating system execution, data definitions, programming
languages, and instruction sets. The IEC6T131-3 specification provides a minimum set of
functionalities that can be extended to meet end user applications.

Instruction block names

Functions and function blocks are represented by a box that displays the name of the
instruction and the short version of the parameter names. For function blocks with an instance,
the instance name is displayed below the function block name.

Instruction block return parameters

 The return parameter of a function has the same name as the function. The return
parameter is the only output.

 The return parameters of a function block can have any name. Multiple return
parameters can provide multiple outputs.

 You can define the parameters of programs for each controller by navigating the tabs for
individual controllers displayed in the Parameter view.

Instruction block loops

For loops in instruction blocks, because they are initialized with a value, you must use local
variables. The following FBD program shows a valid loop where:

« The local variables initialize both inputs of the greater than or equal operator (>=) and
one input of the first AND operator.

» The output of the second AND operator initializes the second input of the first AND
operator.

Figure 25. Instruction block loops
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Execution order of function block diagram programs

Rockwell Automation, Inc.

During program execution, an instruction block is any element in the diagram, a network is a
group of instruction blocks linked together, and the position of an instruction block is based on
its top-left corner.
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The following rules apply to the execution order of an FBD program:

» Networks are executed from left to right and top to bottom.

» Allinputs must be resolved before executing the instruction block. When the inputs
of two or more instruction blocks are resolved at the same time, the decision for the
execution is based on the position of the instruction block (left to right and top to
bottom).

» The outputs of an instruction block are executed recursively from left to right and top to
bottom.

Re-order elements in function block diagram programs

In the function block diagram (FBD) language editor, move elements to change the execution
order.

To re-order elements in FBD programs

* Do one of the following:
- Drag an individual element to the new location. Connections will re-organize when
the mouse is released.
- Use the CTRL or Shift key, or drag the cursor to select several elements, and then
drag the selected elements or the selection area to the new location. Connections
will re-organize when the mouse is released.

Monitoring function block diagram programs

When monitoring function block diagram (FBD) programs, you are monitoring the value for the
input reference, variable, function, and function block at the output of an FBD.

The values appear in color, number, or text values according to their data type:

» Boolean data type output values are displayed in either black or gray, regardless of
whether the value is True or False. A black output value indicates that it can be modified,
and a gray output value indicates that it cannot be changed.

Qutput values of the SINT, USINT, BYTE, INT, UINT, WORD, DINT, UDINT, DWORD, LINT, ULINT,
LWORD, REAL, LREAL, TIME, DATE, and STRING data types are displayed as a number or
text value in the element.

«  When the output value for a number or text value is unavailable, question marks (??)
appear in the output label. Values also appear in the corresponding Dictionary instance.
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Structured text (ST) language

Structured text (ST) is a high-level structured programming language designed for automation
processes. It handles complex procedures that graphic languages like ladder diagrams or
function block diagrams cannot easily express.

FactoryTalk Design Workbench includes an ST editor and supports the elements and
instructions that are supplied with the FactoryTalk Design Workbench software only.

Structured text program development environment

This section introduces the structured text (ST) program language editor.

Figure 26. Structured text program development environment
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ath:
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Toolbox 2
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S manut - : Program Control
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43 timeout = TRUE; propenies n =
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Table 47. ST program development environment
Item Description
o Opens the local variable grid to view the variables that are used by the current program.
e Opens a box to enter a line number to go to. The box shows:
 The current line number where your cursor is located.
»  The number of characters in the current line.
+ The range of line numbers that you can enter in the box.
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Table 47. ST program development environment (continued)

Item Description

When a line number is entered, the line is highlighted. Selecting Enter goes to the line.

Zooms out the editor. It resets when the tab is closed and does not affect other tabs.

Resets the editor to 100% zoom.

Zooms in the editor. It resets when the tab is closed and does not affect other tabs.

Displays or hides the values of the variables, through which you can read the value and check the
project logic.

It does not affect other tabs.

Makes up the primary portion of the structured text editor. In this area, you add all of the text and
make any edits to your ST program.

© © 000

When you are entering instructions, a prompt list displays for possible instructions, and then a
tooltip shows the instruction definition and expected parameters of the selected instruction.

If there are any errors in your code, tooltips will provide error explanations.

e Displays a scaled-down overview of the entire content.

The slider indicates the portion of code displayed in the editor, with errors highlighted in red.
Select or drag the shaded area to quickly jump to different sections in your code.

Use the ST editor commands on page 119 to configure the mini-map.

o Scrolls the page up and down. The short line on the scroll bar indicates your current position.

Adds elements to the ST editor.

Structured text Toolbox

Use the structured text (ST) Toolbox to add program elements to the ST diagram.

Toolbox is displayed by default. If it is hidden, do one of the following:
«  From the pane bar, select E=5.

«  From the View menu, select Toolbox.
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Figure 27. ST Toolbox
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Table 48. ST editor Toolbox

Item

Description

Adds the code snippet IF-THEN-ELSEIF-ELSE-END_IF statement to the editor.

Adds the code snippet Case statement to the editor.

Adds the code snippet FOR statement to the editor.

Adds the code snippet WHILE statement to the editor.

Adds the code snippet REPEAT statement to the editor.

=90 000

Displays the categories of the program elements. Selecting a cateqgory filters the displayed
program elements.

Displays the program elements of the selected category.

(o JHI®

Contains the entered element name for quick finding.

As you enter, elements that contain the search text appear in Toolbox.

Commands in structured text editor

This section introduces the commands when you right-click the language editor or the scroll

bar.

Table 49. Commands in structured text editor

Command

Description

Cut

Moves the selected text or the current line to the clipboard.

Copy

Copies the selected text or the current line to the clipboard.

Paste

Inserts the clipboard text to the current cursor position.

Rockwell Automation, Inc.
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Table 49. Commands in structured text editor (continued)

Command Description

Add element Opens Toolbox if hidden, highlighting your last position.

Create new variable Opens New variable to define a new variable within the code.

Find all references Opens the cross-reference browser to view reference information of the

selected variable.

Select variable Opens the variable selector to replace the selected variable with a new one.

Open instruction parameters Opens the local variable grid to view the variables that are used in the
selected instruction.

Open instruction logic Opens the definition of the selected instruction.

Open monitor Opens the corresponding variable grid to monitor the variable in real time.
The menu is available when the controller is online.

Code snippets
Code snippets are predefined blocks of code for inserting into a structured text program. After
inserting a snippet, fill in the parameters.
FactoryTalk Design Workbench supports the following predefined code snippets:
IF-THEN-ELSIF-ELSE-END_IF
» CASE
« FOR
+  WHILE
» REPEAT
Insert a code snippet

Code snippets are predefined blocks of code for inserting into a structured text program.

To insert a code snippet

1. Inthe structured text language editor, put the cursor where you want to insert a
snippet.

2. Enter the keyword for the snippet, and then select the snippet from the prompt list or
select Tab.
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You can also drag a snippet from Teelbox or double-click it to insert it at the cursor's
location in the language editor.

Toolbox o =

Q. Search

= s ¢ & & |

User-defined

Bit

Program Control
Math

Compare

Move/Copy
RPC

SuUs
SYS_INFO

TND

3. Fillin the parameters for the snippets.

Structured text main syntax
A structured text (ST) program is a list of ST statements.

The following rules apply to the ST program statements:

« Each statement ends with a semi-colon (*;") separator.

» Names used in the source code, such as variables, identifiers, constants, or language
keywords, are separated with:
- Aninactive separator, such as a space
- An active separator, such as ">", which indicates a "greater than" comparison

» Comments are non-executed information and can be included anywhere in an ST
program. Insert comments at the beginning of a line or after code using the following

syntaxes:
- Single-line comments begin with "//" and end at the end of the line.

- Multi-line comments begin with (*" and end with "™)".
- Multi-line comments begin with "/*" and end with "*/".

Indirect bit addressing is supported when a DINT variable or a defined word is used to specify the bit

number.

ST statement types
Assignment statement

vari abl e : = expression;
Function call

* (*Non-formal syntax with all inputs separated by commmas in
set order and output as a separate statenent.*)
Qut put1l : = FUNCTI ON_NAME( | nputl1, | nput?2);
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* (*Formal syntax with inputs and outputs separated by comm
optionally listed and in any order.*)

Qut put 1 : = FUNCTI ON_NAME( | nput Paraneterl : = |nputl,
| nput Paraneter2 : = | nput2);
Function block call
* (*Non-formal syntax with all inputs separated by commas in
set order and output as a separate statenent.*)
FUNCTI ON_BLOCK_| NSTANCE( | nput 1, Input2, ...);
Qut put 1 : = FUNCTI ON_BLOCK | NSTANCE. Cut put Par anet er 1;

CQut put 2 :

FUNCTI ON_BLOCK_| NSTANCE. Cut put Par anet er 2;

* (*Formal syntax with inputs and outputs separated by conma
optionally listed and in any order.*)
FUNCTI ON_BLOCK_| NSTANCE( | nput Paraneter1 : = | nput1,
| nput Par aneter2 : = | nput2, CQutputParaneterl => Qutputl,
Cut put Par anmet er 2 => Qut put 2) ;

Selection statements
[F, THEN, ELSE, CASE...

Iteration statements
FOR, WHILE, REPEAT...

Control statements
RETURN, EXIT...

Special statements
Use special statements to link with other languages.

 Inthe ST language editor, items displayed in different colors:
- Black: Basic code, numbers, and strings of text
- Blue: Keywords and functions
- Green: Comments
- Red: Variables and function block instances
« Theinclusion of inactive separators between active separators, literals, and identifiers
increases ST program legibility. ST inactive separators include:
- Space - blank
- Tabs
- End of line - can be placed anywhere in a program
 Guidelines for using inactive separators:
- Write no more than one statement for each line.
- Use tabs to indent complex statements.
- Insert comments to increase legibility of lines or paragraphs.

Call functions

The structured text programming language on page 117 can call functions. Function calls can
be used in any expressions, and contain properties explained in the following table.
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Function call properties

A function is an instruction block that has input parameters and one output parameter. It can be
written in structured text (ST), ladder diagram (LD), or function block diagram (FBD) languages.

Table 50. Properties of function calls

Property Description

Name The name of the called function written in an IEC 61131-3 language.

Meaning Calls an ST, LD, or FBD function, and gets its return value.

Syntax <variabl e> : = <funct> (<parl>, ... <parN>);

Operands The type of return value and calling parameters must follow the interface defined for the
function.

Return value Value returned by the function.

Figure 28. Function call example

Name Operand

(* Main ST program *)
Return
value (* gets an integer va d converts iy intofa limited time value *)
\‘I ana tlmeprogl —|SPllm1‘;/[ [tprog cmdf) :

appl timer |ANY TO TIME Mana timeprog * ‘LHDP

(* called FBD function named 'SPlimit' *)

When setting the value of the return parameter in the body of a function, you can assign the
return parameter using the same name as the function:

Functi onName : = <expressi on>;

Example: IEC 61131-3 function call
(* Main ST program *)
(* gets an integer value and converts it into a limted time

val ue *
appl _timer := ANY_TO TIME (ana_tineprog * 100);

(* Called FBD function named 'SPlimit"' *)

Call function blocks

The structured text programming language on page 117 can call function blocks. Function
block calls can be used in any expression, and contain properties explained in the following
table.
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Function block call properties

Table 51. Properties of function block calls

Property Description
Name Name of the function block instance.
Meaning Calls a function block from the standard library, or from a user-defined library, and

accesses its return parameters.

Syntax (* call of the function block *)

<bl ockname> ( <pl>, 2 : <p2> ... );

(* gets its return paraneters *)
<result> : = <bl ocknane>. <ret_paranil>;

<resul t> : = <bl ocknane>. <ret_paranm\>;

Operands Parameters are expressions that match the type of the parameters specified for
that function block.

Return value See syntax to get the return value.

Figure 29. Function block call example

(* ST program calling a function block *)

{* declare the instance of the block in the variable editor: *)
(* trigbl : block R TRIG - rising edge detection *)

Operand

Name ‘\(* ction block activation from ST language *)

E= B

(* return parameters access ¥)
Return

value Then nb edge := nb edge + 1; End if;

When setting the value of the return parameter in the body of a function block, you can assign
the return parameter using its name concatenated with the function block name:

Functi onBl ockNane. Qut put Par aNane : = <expressi on>;

Example
(* ST programcalling a function bl ock *)

(* declare the instance of the block in the variable editor: *)
(* trigbhl : block RTRIG - rising edge detection *)

(* Function block activation from ST | anguage *)
trigbl (bl);
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(* return paraneters access *)
If (trighl.Q Then nb_edge := nb_edge + 1; End_if;

Structured text keyboard shortcuts

Rockwell Automation, Inc.

The following keyboard shortcuts are available for use with the structured text language.

Table 52. Structured text keyboard shortcuts

Shortcut Description

Ctrl+6 Opens a box to enter a line number to go to.

Ctrl+M Displays or hides the values of variables.

Ctrl++ Zooms in the language editor.

Ctrl+- Zooms out the language editor.

Ctrl+Space Displays possible completions for your code.
Ctrl+Shift+Space Displays different parameter options as you enter the code.
F1 Opens the context-sensitive help.

Ctrl+F Searches for the entered text in the language editor.
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FactoryTalk Design Workbench settings

Use the Settings page from the File menu to customize the FactoryTalk Design Workbench
application settings.

Switch FactoryTalk Design Workbench language

Use the Settings page from the File menu to switch the language of the FactoryTalk Design
Workbench software. The language change takes effect after restating FactoryTalk Design
Workbench.

To switch FactoryTalk Design Workbench language

1. From the File menu, select Settings.

2. In Settings, on the General page, select a language from the Language list.
3. Select OK.

4. Restart FactoryTalk Design Workbench for the language change to take effect.

Product lifecycle information

Rockwell Automation supports tracking long product lifecycles, helping to innovate and evolve
by identifying current lifecycle stages and managing transitions to modern technologies.

FactoryTalk Design Workbench shows the product lifecycle status of Micro800 controllers in the
Selection pane of the Add device dialog. The lifecycle status also recommends replacement
products if the status of the selected device is End of Life.

When installed, FactoryTalk Design Workbench updates the product lifecycle information if the
last update was over 90 days, or the device can be updated manually.

For the latest product lifecycle information, go to the product lifecycle status page.

Table 53. Product lifecycle status

Lifecycle Status Description

Active Most current offering within a product category.

Active Mature Product is fully supported, but a newer product or family exists. Gain value
by migrating.

End of Life Discontinued date announced-actively executes migrations and last time

buys. Product generally orderable until the discontinued date. Outages on
specific items might occur prior to the Discontinued date.

Discontinued New product no longer manufactured or procured. Limited stock might be
available in run-out mode, regionally. Repair or exchange services might be
available.

Update the product lifecycle information

Use the Settings menu to update the lifecycle status information for your device.
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Prerequisites
» Ensure connection to the network.

»  Rockwell Automation's website is accessible.

To update the product lifecycle information

1. From the menu bar, select File > Settings
2. In Settings, select Product lifecycle.
3. Select Update device lifecycle information.
Select Automatically update every 90 days as needed.

If the update fails, the lifecycle status remains not changed.

Configure general controller settings

Use the Controller - General page to configure the following settings:

« Communication - Timeout: Sets the communication timeout period between 300
milliseconds and 15000 milliseconds. The default value is 3000 milliseconds.

+ Data Log - ZIP file folder hierarchy: Specifies whether to reserve the folder structure
of the data log files or combine data log files to a TXT file when exporting data logs. The
default setting is Preserve source folder structure.

* Recipe - Destination: Defines the destination path on your computer for uploading
recipes from the SD card. The default path is the Downloads folder.

To configure general controller settings

1. From the File menu, select Settings.

2. InSettings, select Controller > General.

3. Customize the settings as needed, and then select OK.
Select Reset to restore the default settings.
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Rockwell Automation Support

Use these resources to access support information.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification rok.auto/support
updates.

Local Technical Support Phone Numbers | Locate the telephone number for your country. rok.auto/phonesupport

Technical Documentation Center Quickly access and download technical specifications, installation instructions, rok.auto/techdocs

and user manuals.

Literature Library Find installation instructions, manuals, brochures, and technical data publications. | rok.auto/literature

Product Compatibility and Download Get help determining how products interact, check features and capabilities, and | rok.auto/pcdc
Center (PCDC) find associated firmware.

Documentation Feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the
form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.
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